# Table of Contents

## Part I Welcome

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>4</td>
</tr>
</tbody>
</table>

## Part II Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Getting Started</td>
<td>6</td>
</tr>
<tr>
<td>Installation</td>
<td>6</td>
</tr>
<tr>
<td>Login</td>
<td>8</td>
</tr>
<tr>
<td>Enter your license key</td>
<td>9</td>
</tr>
<tr>
<td>Populate the data</td>
<td>9</td>
</tr>
<tr>
<td>2 User Interface</td>
<td>11</td>
</tr>
</tbody>
</table>

## Part III Reference

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Menu Bar</td>
<td>15</td>
</tr>
<tr>
<td>2 Course Catalog</td>
<td>32</td>
</tr>
<tr>
<td>3 Class Sessions</td>
<td>38</td>
</tr>
<tr>
<td>4 Personnel</td>
<td>46</td>
</tr>
</tbody>
</table>

---

© 2019 Kaizen Software Solutions
Part IV System Administration

1 Firebird Database Server ........................................................................................................ 63
   Client Server Configuration ............................................................................................... 66
   Shared Database on PC ........................................................................................................ 67
   Terminal Server Configuration ........................................................................................... 68

2 Troubleshoot Connections .................................................................................................... 68

3 Schedule Database Backup .................................................................................................. 72

4 Update The Client Software ................................................................................................ 74

5 Upgrade To Multi-User .......................................................................................................... 75

6 Technical Details .................................................................................................................. 76

7 Move To A New Computer .................................................................................................... 77

8 Move Database To New Server ............................................................................................. 77

9 Configure Email Client ......................................................................................................... 78

10 Audit Trail ............................................................................................................................ 79

11 Advanced Configuration ...................................................................................................... 81
   Command Line Options ....................................................................................................... 81
   Citrix/Terminal Server Configuration .................................................................................... 81
   File Locations ....................................................................................................................... 83
   Change the port number ....................................................................................................... 84
   Multiple Databases Per Server ............................................................................................. 85
   Multiple Firebird Instances ................................................................................................. 86
   ODBC Connections ............................................................................................................ 87

Part V How To (Steps)

1 Add completed training ....................................................................................................... 90

2 Add company name and logo on report ............................................................................. 91

3 Set up annual training requirements .................................................................................... 91

4 Add an External Trainer ....................................................................................................... 92

5 Export a report ..................................................................................................................... 92

6 Set or change a password .................................................................................................... 92

7 Add a read-only or administrator user ............................................................................... 93

8 Manage the system (technical) .......................................................................................... 94

Part VI Getting More Help

© 2019 Kaizen Software Solutions
Part VII  How To Buy

Index

94  0
1  Welcome

Welcome to the Training Manager User Guide

This User Guide is designed to serve both as an introduction and as an on-going reference for the program. If you have just started using Training Manager, check out the Introduction and Getting Started links below. Experienced users will find more details in the Reference section. While using Training Manager, you may press the F1 key or use the menu option Help --> Contents to open this User Guide.

- Introduction
- Getting Started
- Reference
- System Administration
- How To (Steps)

2  Introduction

Training Manager is an easy-to-use Windows application for tracking completed employee training and training requirements. The interface provides a familiar "Microsoft Office" look-and-feel that many users are already comfortable with. Training Manager provides a central repository for storing and retrieving your training records, allowing you to quickly provide transcripts and training compliance reports for individuals, groups, or your entire company without searching through spreadsheets and paperwork. Training manager is designed to work "out of the box" with very little configuration required.

Two editions are available:

- The **Standard Edition** is designed for use on a single workstation.
- The **Enterprise Edition** allows multiple people to share and use the database at the same time.

Training Manager is competitively priced and used around the world. A free trial version is available on the website and can be set up in minutes so you can try the full functionality of the software.

You may also take a look at this quick 3 minute video [Introduction to Training Manager](#).

**How It Works**

Training Record Administrators define Assignments (Required Training) based on Job Role, Group, or Individual. New personnel entered into the system automatically inherit the training requirements for the Job Role and Group which they belong to, eliminating the need to manage training requirements for each individual.

Training Manager compares the Training Assignments to the Training Transcript to produce a Training Status Report. This report allows Managers to quickly assess the training compliance for individuals, groups, or the entire company.
### Features and Benefits at a Glance

<table>
<thead>
<tr>
<th>Features</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Track course information including version history and related documents.</td>
<td>✓ Provides training compliance reports for individuals, groups, or the entire company at the press of a button.</td>
</tr>
<tr>
<td>✓ Schedule Class Sessions and send email reminders for upcoming training.</td>
<td>✓ Enables training record administrators to easily track and manage course information, training requirements, class sessions, and training status.</td>
</tr>
<tr>
<td>✓ Export reports in a variety of formats to send to managers or individuals.</td>
<td>✓ Provides reports for managers to help plan training for their direct reports.</td>
</tr>
<tr>
<td>✓ Print class rosters for students to sign and trainers to return for confirmation of attendance.</td>
<td></td>
</tr>
</tbody>
</table>

### Training Assignments

<table>
<thead>
<tr>
<th>Assign To:</th>
<th>Frequency:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>One time only</td>
</tr>
<tr>
<td>Job Role</td>
<td>Repeat every X months/years, etc.</td>
</tr>
<tr>
<td>Individual</td>
<td>Repeat when version changes</td>
</tr>
</tbody>
</table>

### Training Status Report

- Filter by group or individual
- Filter by course
- Highlight overdue or upcoming training assignments.

### Training Transcript

- Completed Training
- Cancelled Training
- Failed Training
- No Shows

---

**Training Manager Licensing**

- Training Manager licenses may be purchased online with a credit card, bank transfer, or a company purchase order. The license key is delivered via email and unlocks the 10 record limitation of the trial.
- Training Manager licenses include free minor upgrades for the life of the version and major upgrades for one year. Upgrading is voluntary and not required to continue using the version of the software that has been purchased.
- Support by email is available free for both trial and licensed users (see additional support information in the next section).
- Kaizen Software Solutions also offers upgrades from the Standard Edition to the Enterprise Edition for the difference in price.
<table>
<thead>
<tr>
<th>Product</th>
<th>Number of users</th>
<th>Price (USD)*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training Manager Standard Edition</td>
<td>Single User Workstation</td>
<td>$495</td>
</tr>
<tr>
<td>Training Manager Enterprise Edition</td>
<td>Unlimited Users on Network</td>
<td>$995</td>
</tr>
</tbody>
</table>

*Prices in EUR and other currencies based on the exchange rate at the time of purchase. Check the purchasing page on the website to confirm current pricing.

# Training Manager Support

All Training Manager support is available free by email. Additional paid support by telephone is not available at this time. This support model allows our customers around the globe to reach an appropriate expert for their specific technical, sales, or customer service question without wading through multiple levels of support and call backs. Support tickets may be submitted through the website at [www.kzsoftware.com](http://www.kzsoftware.com).

See Also:
- **Getting Started**
- **User Interface**

Advanced users may want to skip ahead to the Reference section.

## 2.1 Getting Started

Choose from the following topics to get started:

- **Installation**
- **Login**
- **Enter your license key**
- **Populate the data**

Or for experienced users, jump to the Reference section.

### 2.1.1 Installation

**To install from the web:**

1. Download Training Manager from the website at:
2. Open/Run the setup file, TrainingManagerStandardSetup.exe. or TrainingManagerEnterpriseSetup.exe
3. Follow the instructions in the installation wizard to complete the installation.
Open/Run the setup file to begin the Setup Wizard, and then click the Next button.

Read the license agreement, and then select "I accept the agreement" before clicking the Next button to continue.

You may leave the default installation location selected, or select a different location if needed.

A shortcut will be created in the Start Menu Folder. Click the Next button to continue.

Leave the checkbox checked to create a desktop icon. Click the Next button to continue.

Click the Install button to begin the installation.

Also note: if your computer does not have the .NET 2 framework installed already, the installer will automatically download and install it before continuing.

Click the Finish button and wait a few moments as the software initializes the first time.

To install on a PC without internet access:

1. If the computer doesn’t have the .NET 2 Framework installed, download it onto a disk, flash drive, etc. and then install it. To check, you can look at the Add/Remove programs list in Windows and look for an entry "Microsoft .NET Framework 2.0". The .NET Framework can be downloaded at the links below:

   .NET 2

2. After confirming or installing the .NET Framework, install Training Manager.

3. The setup file can be downloaded to another computer and then copied to a disk, flash drive, etc, by
right-clicking on the download link for the Edition you need, and then selecting 'save target as' to
download the setup file. Copy this file to the other computer and run the installation wizard.

4. After opening Training Manager, enter your license key.

2.1.2 Login

When you open Training Manager for the first time after installation, you will be automatically logged in
to the local database with the admin account. This account has the following default credentials:

   Login Name: admin
   Password: admin
   (both are lowercase)

If you click the log off link or change the user name or password, you will need to login using the Login
screen in order to access Training Manager. Note that both the Login Name and the Password are case-
sensitive.

<table>
<thead>
<tr>
<th>Field/Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Name</td>
<td>This is the login name set on the Personnel form.</td>
</tr>
<tr>
<td>Password</td>
<td>This is the password set on the Personnel form. It will be blank if it hasn't been set yet.</td>
</tr>
<tr>
<td><strong>Login button</strong></td>
<td>Click the Login button to login to the application.</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td><strong>Remember my password</strong></td>
<td>Check this box if you are the only one using the computer or you have set up a read-only account on a public computer.</td>
</tr>
<tr>
<td><strong>Sign me in automatically</strong></td>
<td>Check this box if you are the only one using the computer or you have set up a read-only account on a public computer.</td>
</tr>
<tr>
<td><strong>Change password link</strong></td>
<td>Click this link to change the password for any user (requires the existing password in order to change it to a new one).</td>
</tr>
</tbody>
</table>

### 2.1.3 Enter your license key

After purchasing a license key, you will need to enter it into the software to unlock the 10 record limitation imposed while in Trial mode.

1. Select the menu item **Unlock Trial Mode ➔ Enter License Key**.
2. Enter your license key into the License Key form.
3. Press the enter key or click the Ok button to save.

![License Key Form](image)

**License Key Form**

Note: The button will remain disabled if the key is invalid.

A Standard Edition license key will only work in the Standard Edition of Training Manager, and an Enterprise Edition license key will only work in the Enterprise Edition of Training Manager.

### 2.1.4 Populate the data

Data may be entered into the database manually using the data entry forms, or by importing it from .csv files. If you plan to import your data, please see the Import Data section.

Data may be entered in any order as needed; however, it can be helpful when you start out to enter your data in the order described below for a smooth flow, minimizing the back-and-forth jumping from one area of the database to another. Below is a summary of the steps to populate your database. For detailed information about any of the steps, please see the Reference section.

**Step 1: Selection Fields**
Open the menu option Tools --> Manage Selection Fields. Here you can add values for "Classifications", "Job Roles", and training "Locations".

If you don't have all of the data now, that's ok. You can always enter it in later, but entering it now will allow you to easily select it when adding Personnel and Class Session records in the following steps.

**Step 2: Personnel Groups**

If you have a list of your personnel groups, you may organize the Personnel Group folder list now. Otherwise, you can add them dynamically when adding a new personnel record. To add new personnel group, click the "New Group" button on the main Personnel tab located on the left just above the personnel group folders.

You can edit the position within the folder hierarchy by right-clicking on a folder and then selecting Edit. Changing the "Parent" group will move the folder up or down within the hierarchy based on your setting.

**Step 3: Personnel**

Next, enter your master list of Personnel on the Personnel tab. Begin a new record by clicking the "New Person" button.

If you have a list of Personnel grouped by Supervisor, begin by entering the supervisor first, and then their direct reports. When you enter the Supervisor, check the "Supervisor" checkbox on the form. This will add the person to the Supervisor list so you can select them as the Supervisor for the direct report records.

If the person is also a Trainer, select the "Trainer" checkbox so they will be available in the "Trainer" selection fields. If the person is an outside trainer who is not subjective to your organization's internal training requirements, select the "Exclude from required training" checkbox. This will ensure that they do not show up as overdue on your training status reports.

**Step 4: Course Categories**

If you have a list of course categories, you may organize the Course Category folder list now (similar to the way Personnel Groups are managed). Otherwise, you can add them dynamically when adding a new Course record. To add new Course Category, click the "New Course Category" button on the main Course Catalog tab located on the left just above the Course Category folders.

You can edit the position within the folder hierarchy by right-clicking on a folder and then selecting Edit. Changing the "Parent" Category will move the folder up or down within the hierarchy based on your setting.

**Step 5: Courses**

Next, enter your master list of Courses on the Course Catalog tab. Begin a new record by clicking the "New Course" button. If you have a default Trainer and Location, you may select it from the list. These values will then automatically be populated when adding a new Class Session.

**Step 6: Assignments**

Assignment records are used to define the criteria for Required Training. Some organizations refer to
this using the term Training Matrix. With the Courses, Personnel, Groups, and Job Roles defined, you can add new Assignment records to set up the requirements for these entities. See the Assignments page in the reference section for more details.

**Step 7: Class Sessions**

Class Session records are used to record the information about who has or will attend a course and when. You can use it to enter upcoming training or past training sessions. For past training sessions, be sure to update the Status for the enrolled personnel. See the Enrolled Students page in the reference section for more details.

Also See: Screencast: Getting Started Populating Data In Training Manager

### 2.2 User Interface

The Training Manager window is divided into 4 main areas: the Menu Bar, the Navigation Tabs, The List View, and the Navigation Folders.
The Menu Bar

The menu bar contains the File, View, Tools, and Help menu items.

More information on each of these menu items is available by going to the Reference section here.

The Navigation Tabs

The Navigation tabs allow you to easily switch between the Course Catalog, Class Sessions, Personnel, Assignments, and Reports sections.

More information on each of these tabs is available by going to the Reference section here.

The List Views

The list views display the data in a spreadsheet-like view of rows and columns.

- The toolbar just above the list view contains buttons to add/edit/delete records in the list view.
- Records can also be opened by double-clicking on a row or right-clicking on a row and selecting the Edit menu item.
- Sort the data by any of the columns in the list view by clicking on the header for that column. Click again to reverse the sort order.
- Change the order of the columns in the list view by clicking down on a column header and dragging it while holding the mouse button down. Then release the mouse button to drop it in a new location.
- Filter the data using the filter links in the upper right (eg. Active/Inactive/All), or by entering a few characters in the Quick Search box.
- Right-click on the list view and select Show Columns to select which columns are displayed in the list view.
The Navigation Folders

The Course Catalog list view and the Personnel list view both contain navigation folders on the left side of the screen. These folders allow you to organize the data into groups and quickly filter the list by clicking on a folder. You may create new folders by right-clicking on the navigation folder area and selecting the "New" option from the menu. Or, rename an existing folder by right-clicking on the folder and selecting the "Edit" menu option.

Date Fields

The date fields on the data entry forms contain a calendar field to ensure that the date gets entered into the database in the correct format. This field has several features:
To update the entry using the keyboard:
- Use the left and right arrows on the keyboard to move back and forth within the field.
- Use the up and down arrows on the keyboard to change the values, or type the values in using the number keys on the keyboard.
- Use the tab key to exit the date field, moving the cursor to the next field on the form.

To update the entry using the mouse:
- Click the down arrow at the right of the field to drop down the calendar and select a new date.
- Click the left and right buttons to change the month.
- Click the name of the month displayed at the top of the calendar pop-up to select a different month.
- Click the year displayed at the top of the calendar pop-up to select a different year.
- Click the "Today" area near the bottom of the calendar to set the date to Today's date.

**Attachment Fields**

Attachment fields allow you to add multiple attachments to a record. The file attachments may be of any type, and they will be stored in the database.

- Drag and drop files onto the empty space in an Attachment field to add them to the record.
- Or you may click the Attachment icon in the toolbar to select a file to add.
- Double-click a file in the attachment field to open it.

3 **Reference**

The Reference section provides a detailed explanation of each area of Training Manager. Click on a link below for details about the item.
3.1 Menu Bar

The menu bar is located at the top of the main window. Click on any of the menu items listed below for more information.

Menu Bar Items

- File
- View
- Tools
- Help

3.1.1 File Menu

The File menu contains the menu items listed below. Click on a link below for complete details.

File Menu Items

- Backup
- Restore
- Change Password
- Log Off
- Exit

3.1.1.1 Backup

The Backup function creates a compressed data file containing a full backup of the database. This feature allows you to create a backup manually at any time. If you are using the Enterprise Edition, you may also schedule a nightly backup.
Steps to backup a database

1. Select **File → Backup** to open the Backup database dialog box.
2. Click the Browse button to select a location for the file, and enter the name of the file to save.
3. Click the "Backup" button to perform the backup.
4. Dismiss the confirmation box. If the Backup operation fails for any reason, close the application and then reopen it and perform the Backup operation again.

**Key Points:**
- The backup file is a compressed snapshot of the database. It cannot be opened directly. To restore the database from the backup file, use the menu option: **File → Restore**.
- Be sure to store the backup file on an external or remote drive so it will be available in case your hard drive crashes and becomes inaccessible. If possible, copy the file to a network server that is backed up.
- If you are using the Enterprise Edition with a remote database server, ask your server administrator to schedule a nightly backup using the instructions on our website.
- It's a good practice to periodically audit the backup and restore operation. To perform the audit, test the restore operation on a different database to ensure that the backup file can be restored properly. Note that the restore operation will completely overwrite the target database, so use a local test database on another computer which is not connected to your live database to ensure that no changes are made to the live database when performing the audit.
3.1.1.2 Restore

The Restore function restores the data from a compressed backup file over an existing database. This operation will completely overwrite the current database with the contents of the backup file.

To ensure a successful restore operation, it is important that no one else is using the database and no one attempts to log into the database during the restore operation.

Steps to restore a database

1. Select File → Restore to open the Restore database dialog box.
2. Click the Browse button and select a backup file that you have created earlier.
3. Click the Restore button and click "Yes" when asked if you want to proceed.
4. Wait while the database is restored. This may take several minutes for a large database. Do not interrupt the Restore operation, or the restored database may be corrupt.
5. Dismiss the confirmation box. If the restore operation fails for any reason, close the application and then reopen it and perform the Restore operation again.

Key Points

- It is critical that no one else is logged into the database or attempts to login to the database while the restore process is running.
- The restore process may take several minutes to complete, and it should not be interrupted.
- The restore process will completely overwrite the database with the contents of the backup file. Any data entered since the backup file was created will be overwritten.
- It's a good practice to periodically audit the backup and restore operation. To perform the audit, test the restore operation on a different database to ensure that the backup file can be restored properly. Note that the restore operation will completely overwrite the target database, so use a local test.
database on another computer which is not connected to your live database to ensure that no changes are made to the live database when performing the audit.

3.1.1.3 Change Password

The Change Password menu item opens the dialog box used to change a user's password. You must know the user's current password in order to use this feature.

If you do not know the user's current password, you may use the "Set Password" function on the Personnel form (for System Administrators only).

Steps To Change A Password:

1. Select the Login Name of the user whose password you would like to change.
2. Enter the user's current password.
3. Enter a new password for the user.
4. Enter the new password for the user again to confirm it.
5. Click the Ok button to complete the change.

3.1.1.4 Log Off

Select the Log Off menu item to log off the current user.

See Also: Login

3.1.1.5 Exit

Select File → Exit to close the application. This has the same effect as clicking the 'X' in the upper right corner.

3.1.2 View

Select any of the styles in the View menu to change the application window colors. Examples of the different styles available are shown below:
3.1.3 Tools

The Tools menu contains the menu items listed below. Click a link below for complete details.

**Tools Menu Items**

- Manage Selection Fields
3.1.3.1 Manage Selection Fields

The **Manage Selection Fields** menu opens the dialog box which allows you to add, edit, delete, and reorder the selection field values.

![Manage Selection Fields Dialog]

**Steps to add/edit/delete selection values**

1. Select **Tools → Manage Selection Fields** to open the dialog box.
2. Select a Selection Field from the list on the left.
3. Use the buttons on the right to add, edit, delete, or reorder the selection values.

3.1.3.2 Reassign Direct Reports

The **Reassign Direct Reports** menu opens the dialog box which allows you to reassign direct reports from one Supervisor to another. This function updates a supervisor's direct reports to a new supervisor all at once instead of opening each direct report's personnel record and making the change to the Supervisor field one at a time.
Steps to reassign direct reports

1. Select Tools → Reassign Direct Reports to open the dialog box.
2. Select a Supervisor in the "From" field to move the direct reports from.
3. Select a Supervisor in the "To" field to move the direct reports to.
4. Click the "Reassign" button to complete the reassignment. All personnel who reported to the "From" supervisor will be reassigned to report to the "To" supervisor.

3.1.3.3 Database Connection

The Database Connection menu (Enterprise Edition only) opens the dialog box which allows you to switch between a local database and a remote database.
**Database Connection Dialog**

**Connect to single user local database file (file path):**
Select this option to connect to the local database file. This file is located in the Windows All Users Application Data directory by default.

**Connect to multi-user database server (Server name or IP Address):**
Select this option to connect to a database on a server. Enter the name of the server or the IP Address that your server administrator has provided. The server must have the Firebird database component installed on it. The connection will use TCP/IP. You cannot connect using a shared folder or UNC path. For more information, see the Database Server Configuration Page.

**Connection Test**
Click the "Test Connection" button to verify that your connection is successful.

**Check Firebird Version**
Click the "Check Firebird Version" button to determine the version of Firebird database in use.

**Advanced**
**DB Port:**
Set the port number that the Firebird database server is listening on. The default value is 3050. This value must match the "RemoteServicePort" value set on the server in the firebird.conf file. Note: the Firebird service must be restarted after making changes to the firebird.conf file. Also, be sure to update the windows firewall to allow TCP connections on the specified port number.
DB Name (Alias):
Set the name of the database alias defined in the aliases.conf file on the server. The default value is: "TrainingManager" (no quotes or spaces). Note: the Firebird service must be restarted after making changes to the aliases.conf file.

SYSDBA Password:
Enter the value of the Firebird SYSDBA password. This value will be "masterkey" by default, and it can only be changed on the server by your database administrator. If you receive a message which indicates the Login Name / Password was not recognized, try using the default password "masterkey". If this does not work, contact your database server administrator.

3.1.3.4 Import

The Import menu allows you to import the master course and personnel data as well as historical training records (transcripts) from a .csv file. If your data is currently in MS Excel format (.xls), you will need to save the spreadsheet as a .csv file before importing the data.

Existing records will be updated when the "Update" checkbox is checked on the import tab, or if a matching record cannot be found, the record will be added as a new record. Training Manager uses the following criteria when checking for a matching record to update:

- **Update Personnel Record:**
  If an existing Personnel record has a matching Personnel Number or Login Name in the source file, and the fields have been mapped on the Field Mappings tab, the record will be updated with any changes.

- **Update Course Record:**
  If an existing Course record has a matching Course Number or Course Title field in the source file, and the fields have been mapped on the Field Mappings tab, the existing record will be updated with any changes.

- **Update Training Record:**
  If an existing Transcript entry has a matching Course, Person, and Completion date, and the fields have been mapped on the Field Mappings tab, the existing record will be updated with any changes.

- **New Personnel, Course, or Training Record:**
  If a matching record is not found, a New record will be added to the database.

You may import a source file which contains all or only some of the data fields. For example, for initial import, you may want to import as many data fields as possible. However, to update only the changes in Job Role, Personnel Group, or Employment status, you may want to use an import file which contains just the Personnel Number field and the Job Role, Personnel Group, or Employment Status field.

**Important:** Be sure to test out your import files on a test database and backup your production database prior to importing the data. It is a good idea to develop a repeatable and consistent process for creating your import file if you plan to perform the operation on a regular basis.

**Data source tab:**
The Data Source tab is the first tab on the Import Wizard accessed using the menu option Tools --> Import. This tab allows you to select an import file and configure the settings to match the import file format.

**Import file**

The import file is the .csv file which contains the data to import. For example, if you have a list of personnel in an Excel spreadsheet, you can save the spreadsheet as a .csv file using the File Save As
command in Excel, and then import the personnel records rather than entering them all manually.

The following sections are examples of the contents of a valid .csv file for Personnel, Courses, and Training Records. You may copy and paste this data into a Notepad document and save it to test importing the file into the system:

Example Personnel Data:
"PERSONNELGROUPNAME","LOGINNAME","FIRSTNAME","LASTNAME","EMAILADDRESS","PHONENUMBER","HIREDATE","CLASSIFICATION"
"Engineering","jdoe1","Jonathan","Doe1","jdoe@company.com","123-123-1234","2009-04-20T00:00:00-07:00","Full-Time"
"Human Resources","jsmith1","Jane","Smith1","jsmith@company.com","123-123-1235","2009-04-20T00:00:00-07:00","Full-Time"

Example Course Data:
CourseTitle,CourseNumber,CourseCategory,DefaultLocation
"Customer Service, Introduction","CS101","Internal","Training Room #1"
"Customer Service, Advanced","CS400","Internal","Training Room #2"

Example Transcript Data:
FirstName,LastName,Course,Date,Score
John,Doe,An Introduction to Training Manager,1/12/2010,20
John,Doe,An Introduction to Asset Manager,1/10/2010,90
Jane,Smith,An Introduction to Training Manager,1/12/2010,75

See Also: Sample .csv files for importing located in the Program Files\Training Manager directory.

Malformed .csv File Message:

MS Excel will sometimes leave out the ending comma if the last column in the file contains data in only some of the rows. For example, if you have a Notes column in the last column of your file, and only a few of the rows have any data in the Notes field, the file may not get saved in a proper .csv format with an ending comma for the empty columns. In this case, you may want to delete the last column and then resave the file for import, or ensure that each row contains data in that column in order for the import file to be saved in a valid .csv format.

You may need to remove any unused or empty columns in your source file to avoid creating a malformed .csv file.

Additional Troubleshooting For Malformed csv files:

The "Save As file type" feature in Excel will sometimes create a malformed csv file which cannot be used in the import process; however, you can try exporting to a unicode text file instead. The Unicode text option produces an output similar to tab-delimited text, but it allows for the inclusion of non-ASCII characters such as Chinese, Arabic or Hebrew letters, which otherwise may appear as question marks.

To convert from an Excel file to a tab delimited text file:

2. When using this option, be sure to select the .txt file instead of the .csv file when you select the import source in Training Manager.
3. Also, change the field delimiter to a tab instead of a comma on the Data Source tab.

File format

Field Delimiter: For .csv files, the field delimiter will be a comma. This is the character which
separates the fields in the file.

Text Qualifier: The Text Qualifier is used to surround the values for each field. For example, if you have a field with a comma in it, you will need to include the value in quotes so that it is recognized correctly.

First row contains column names: Check this box if the first row of your import file contains file names.

Data preview

The Data preview section displays the first few rows of the import file so you can check to see if the settings are correct.

Field mapping tab:
This tab provides options for mapping the data from the fields in your source file to the fields in the Training Manager database. The Source Fields are listed in the column on the left side. For each field that you want to map to a Training Manager field, click in the area to the right of the field and then select a destination Training Manager field to map it to.

Source Field: The source field is the name of the field from the import file.
Training Manager Field: The Training Manager Field is the corresponding field in Training Manager to map the source field to.

Import tab:
Click the "Import" button on this tab to import the data into the database. A summary of the import results will be provided in the Import Summary section after the import process is completed.

3.1.3.5 Export

The Export menu item opens the Export Data dialog box with options for exporting data out of the database.

![Export Data Dialog]

Steps to Export Data
1. Record Type: Select the type of records to export.
2. Data Format: Select the format of the file to create.
3. File Name: Click the Browse button and select a location and file name where the data file will be created.
4. Click the Export button to export the data.

3.1.3.6 Options

The Options dialog allows you to set options for the following areas:

- Reports
- Company Logo
- Audit Trail
- Email Template

Reports

The Reports tab allows you to set a custom header/footer/logo for each report. Click the Edit button to edit an existing header or footer, or Click the New button to add a new header or footer.
**Company Logo**

The Company Logo tab allows you to upload a Company Logo image to be displayed on reports.

**Audit Trail**

The Audit Trail tab allows you to turn the audit trail on or off, as well as delete entries from the audit trail. These functions are available to system administrators only, and the actions will be logged.
The Email Template tab is used to set default values to be used when sending class session reminders. You can select the default message recipients as well as the Subject and Message. Field values from the Class Session record can be inserted using “tags” in brackets as shown below. See the list of available tags in the table.
### Field/Item

**To**
- **Description**: The "To" field contains the default list of recipients who will be added to the "To" list on the email message.
  - Check the "Attendees" box to include all personnel listed in the class session - enrolled students area.
  - Add additional email addresses separated by commas or semi-colons if needed.

### CC
- **Description**: The "CC" field contains the default list of recipients who will be added to the CC list on the email message.
  - Check the "Trainer" box to include the Trainer listed on the class session.
  - Check the "Supervisor" box to include the supervisors for all personnel in the class session - enrolled students area.
  - Check the "Current User" box to include the user.

---

```
This is a reminder that you are currently enrolled in the following class session:

Course Title: [CourseTitle]
Start Date/Time: [StartDateTime]
End Date/Time: [EndDateTime]
Location: [Location]
Trainer: [Trainer]
```
### 3.1.4 Help

The Help menu contains the menu items listed below. Click a link below for complete details.

#### Help Menu Items

- **Contents**
- **Check for updates**
- **Ask a question/Send feedback**
- **About Training Manager**

#### 3.1.4.1 Contents

The **Contents** menu opens this User Guide.

#### 3.1.4.2 Check for updates

The **Check for updates** menu initiates a connection to our update server to compare the version of the software you are using with the current version of the software. A pop-up message will notify you to let you know whether you are using the current version of the software. If you are using an older version,
you will be provided with an option to download the update. To install the update, download the setup file when prompted, and click Open or Run to update your software. Your database will remain intact, so you will not lose the data that has been previously entered.

Some updates may require a change to the database schema after the software has been updated. In these cases, you will be notified the first time you open the new version that it needs to update the database. If you receive this message, it is important that no one else has the software open before you continue, and Training Manager will automatically update the database schema for use with the current version of the software.

In a multi-user environment, it is important that all users have the same version of the software installed. Users with an older version of the software may receive an error message when connected to a database which has been updated.

If a corporate firewall prevents you from connecting to our update server, you may also download the software from the downloads page on our website. This is the same software which can be downloaded through the Check for updates menu.

For information about the changes that have occurred, check the Product Updates section on our blog.

3.1.4.3 Ask a question

The menu option Ask a question / Send feedback will open a dialog box you can use to contact Support. You may use this form to contact us about:

- Question
- Enhancement Request
- Bug Report
- Other Feedback
3.1.4.4 About Training Manager

The About Training Manager menu item opens a dialog box with information about the currently installed Training Manager software, including the version number.

3.2 Course Catalog

The Course Catalog is your organization's master list of Courses offered internally or externally. See the following topics in this section for more details:

- Courses List View
- Course Form

3.2.1 Courses List View

A complete listing of courses is located in the Courses List view on the Course Catalog tab.
Course List View
- Double-click on a course row to open and edit the record.
- Select the columns to appear in the list view by right-clicking on the list view and then select **Show Columns**.

Toolbar
- Use the **Toolbar** buttons to:
  - New Course: Add a new course to the list.
  - Edit: Edit the selected course.
  - Delete: Delete the selected course.
  - Export: Export the list of courses.

Quick Search
- To find a course quickly, select All Categories and then enter a few characters of the course title in
the Quick Search box near the upper right. The list will be filtered in real-time to display only those courses matching your search.

Filters
- Use the Filters to toggle between viewing the Active/Inactive courses. Courses with an Inactive status will not appear in the selection lists for new Class Sessions, but will remain in the database for historical reporting.

Course Categories
- Click a Course Category folder on the left to show all courses within that category (similar to the File Explorer in Windows).
- Click the New Course Category button to add a new Category which will appear as a folder in the Folder Navigation area. Course Categories will also be added to the category selection field on the Course form.
- Right-click on a category/folder to edit or delete it.

See Also
Course Form

3.2.2 Course Form

The Course form contains all of the information about a specific course.

Fields
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Title</td>
<td>This text field is for the title of the course. The values entered in this field are displayed in the Course selection field on the Class Session form.</td>
</tr>
<tr>
<td>Course Category</td>
<td>This selection field is for the Course Category. You may select from an existing category, or enter a new category. The categories are also displayed as folder in the Navigation Folder area.</td>
</tr>
<tr>
<td>Course Credits</td>
<td>[Optional] This numeric field is for the number of credits the course is worth.</td>
</tr>
<tr>
<td>Course Status</td>
<td>This selection field allows you to set a Course to be Active or Inactive. Active Courses are available for selection when creating a new Class Session record. Inactive Courses will remain in the database for reference and allow you to maintain historical training records for those Courses, but they do not show up in the selection field when adding a new Class Session record.</td>
</tr>
<tr>
<td>Course Number</td>
<td>The Course Number is a unique number which identifies this course. This number may be auto-generated by Training Manager, or you may select &quot;Manual&quot; and enter your own course number.</td>
</tr>
<tr>
<td>Default Trainer</td>
<td>This selection field is used to set the Default Trainer to use when adding a new Class Session for this course. The list of Trainers in the list is based on entries in the Personnel section which have the &quot;Trainer&quot; checkbox checked.</td>
</tr>
<tr>
<td>Default Location</td>
<td>This selection field is used to set the Default Location to use when adding a new Class Session for this course. The list of Locations can be managed using the menu option Tools --&gt; Manage Selection Fields.</td>
</tr>
<tr>
<td>Default Fixed Cost</td>
<td>The default Fixed Cost for new Class Sessions. This may cover items such as room rental, trainer fee, or other items which do not change based on the number of students.</td>
</tr>
<tr>
<td>Default Student Cost</td>
<td>The default cost per student when enrolling a new student into a class session. This can cover items such as workbooks or other materials provided to each student in a class.</td>
</tr>
</tbody>
</table>

**See Also**

- Course Version History
- Assignments
- Attachments
- Notes

**3.2.2.1 Course Version History**

Each unique course may have many course versions associated with it. Add a new course version by clicking the "New Version" button in the Course Version History tab.

Click the "Edit Version" button or double-click a row to open the Course Version form.
### Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Title</td>
<td>[Read Only] Displays the Course Title</td>
</tr>
<tr>
<td>Course Number</td>
<td>[Read Only] Displays the Course Number</td>
</tr>
<tr>
<td>Course Version</td>
<td>A numeric field which identifies the course version. This field will automatically increment each time you add a new version, and you may change the value if needed. This field can be used with Assignments to automatically require retraining when a new version of a course is released. Also, see the note below*.</td>
</tr>
<tr>
<td>Required</td>
<td>This checkbox indicates whether this version of the course is required. This will apply to the status reports if there are &quot;Version Change&quot; Assignments for this course. In most cases this box should be left checked in order for the Course to appear in Required Training and Status reports. You may uncheck this box for a new course version that doesn't require retraining for a version based assignment (eg. an update for a minor typo or formatting change to the course or related documents).</td>
</tr>
<tr>
<td>Effective Date</td>
<td>This is the date when the new version becomes effective. This value may be set to a future date if you have a new version which will become effective in the coming week and you would like to run a report to see who needs to be trained on it (based on the &quot;Version Change&quot; Assignments).</td>
</tr>
<tr>
<td>Document Title</td>
<td>[Optional] This field can be used to track the name of a related document title such as a Standard Operating Procedure or other training document.</td>
</tr>
<tr>
<td>Document Number</td>
<td>[Optional] This field may be used to track the Document Number for a document related to the course.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Document Version:</td>
<td>[Optional] This field may be used to relate a document version to the course version for the case in which a separate versioning system is used for related documents. Also, see the note below*.</td>
</tr>
</tbody>
</table>

*Note: The combination of the course version and the document version will be displayed in selection fields and reports in the format: "Course Version [Document Version]".

For example:
Course Version = 1
Document Version = 3A.1
The selection field or value on the report will be displayed as: 1 [3A.1].

3.2.2.2 Assignments

The Assignment tab on the Course Form contains the Group, Job Role, and Individual Assignments that have been created just for this course. This is a filtered version of the main Assignments list, and is an alternative place to access the Assignments when updating a specific course.

For more details about Assignments, see the main Assignments section.

3.2.2.3 Attachments

The Attachments tab on the Course form may be used to store course materials. You may upload any type of file here, and it will be available to download from Training Manager. All attached files are stored in the Training Manager database.
3.2.2.4 Notes

The Notes tab on the Course form may be used to store miscellaneous notes about the course.

You can add links to files using the file protocol.
Example: <file:///[Path to file]>

3.3 Class Sessions

Class Session records contain the details for specific training sessions including the date/time, trainer, trainees, and more. For complete details, see the following sections:

- Class Sessions List View
- ClassRosterOptions
- Class Session Form

3.3.1 Class Sessions List View

The Class Sessions list view displays a list of all class sessions that have been entered into the database.

<table>
<thead>
<tr>
<th>Course Number</th>
<th>Course Title</th>
<th>Start Date</th>
<th>End Date</th>
<th>Trainers</th>
<th>Date Updated</th>
<th>Available Seats</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRS0000005</td>
<td>Managing change in the workplace</td>
<td>5/20/2009 9:00 AM</td>
<td>5/26/2009 11:00 PM</td>
<td>10</td>
<td>5/22/2009 4:26 PM</td>
<td>9</td>
</tr>
</tbody>
</table>

Class Sessions List View

**Filters:**
Click a pre-defined filter link located above the Quick Search box to quickly filter the list.

<table>
<thead>
<tr>
<th>Filter Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Show all class sessions in the list. Use this filter if you need to find older class sessions.</td>
</tr>
<tr>
<td>Upcoming</td>
<td>Show only class sessions scheduled to start in the future. Use this filter if you are scheduling personnel for an upcoming class.</td>
</tr>
<tr>
<td>Recent</td>
<td>Show class sessions which have a Start Date within 30 days before or after today. This filter is handy if you have thousands of class sessions and want to improve the loading time and filter out the older sessions while still having access to sessions coming up in the next 30 days.</td>
</tr>
<tr>
<td>Incomplete</td>
<td>Show class sessions which have incomplete entries (1 or more trainees with status set to &quot;Enrolled&quot;, &quot;Pending&quot;, or &quot;Wait-Listed&quot;). This filter will help you find records which need status updates to &quot;Completed&quot;, &quot;Cancelled&quot;, etc.</td>
</tr>
</tbody>
</table>

**Quick Search:**
Enter a few characters of the course title or course number in the Search box near the upper right to quickly filter the list.

**Toolbar Buttons:**

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Session</td>
<td>Opens a new Class Session form. Use this to schedule a new class, or to add the details for a recently completed class that hasn't already been scheduled.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the currently selected (highlighted row) class session.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected class session.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the Export Data dialog box to allow you to export the list of Class Sessions to a .csv file.</td>
</tr>
<tr>
<td>Enroll Students</td>
<td>Opens the Enroll Students window to allow you to manage the students enrollment in the currently selected class session.</td>
</tr>
<tr>
<td>Class Roster</td>
<td>Opens the Class Roster report for printing. This report contains the class session information including a list of attendees with spaces for signature/date.</td>
</tr>
<tr>
<td>Email Reminder</td>
<td>Opens the default email client and pre-fills the subject and body of the message as well as the &quot;To&quot; fields to remind attendees of the upcoming class session.</td>
</tr>
</tbody>
</table>

**Sorting:**
Click on a column header to sort the data by that column. Click again to re-sort the column in the opposite direction.

**Show Columns:**
Right-click anywhere on the list to display the context menu, then select "Show Columns" to select which columns you would like to display in the list.

### 3.3.2 Class Roster Options

Click the drop down arrow to the right of the "Class Roster" button to set options for Extra Rows or to print a Blank Roster.

#### Extra Row Options

In some cases there may be last minute changes after initial enrollment, or you may have extra trainees enrolled after the Class Roster was printed. You can use the "Extra Rows" option to add extra rows to the end of the Enrolled Student List on the Class Roster. To set the number of extra rows, click the drop down arrow next to the Class Roster button and select "Extra Rows...". This will open the Extra Row Options form as shown below:

- **This time only**: Set this value for the number of rows to add to the currently selected Class Roster for this time only.
- **Default value**: Set the Default number of extra rows which will be added whenever a Class Roster is printed using the default Class Roster button.

#### Blank Roster Options

At times there may be some information which is unknown at the time of printing the Class Roster. To
print a blank roster, click the drop down arrow next to the Class Roster button and then select "Blank Roster". This will open the Blank Options form as shown below:

- **Blank Header**: Check this box to print a class roster with the header values blank (Course Title, Version, Location, etc.).
- **Blank Student List**: Check this box to print a class roster with blank rows in the student listing area.

Examples:

1) If you have the information for the training course(s) which will be taught, but you don't know who will show up, you can print a class roster with the Header information filled in, but the Student Listing set to blank as follows:

   - Blank Header: Not Checked
   - Blank Student Listing: Checked

2) If you want to print extra blank sheets to be filled in completely by hand, set the values as follows:

   - Blank Header: Checked
   - Blank Student Listing: Checked

   Use the print options to print additional copies, or print one page and use a copy machine for extra copies.

### 3.3.3 Class Session Form

The **Class Session form** contains the details for a specific session of training.
Class Session Form

Fields and Form Elements

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session ID</td>
<td>[Read Only] A unique number which identifies this Class Session.</td>
</tr>
<tr>
<td>Course</td>
<td>The name of the course taught at this Class Session.</td>
</tr>
<tr>
<td>Version</td>
<td>The Version selection field displays the Course Version and the Document Version in the format &quot;Course Version [Document Version]&quot;. The Document Version will be included in brackets unless it is blank. The values available for selection can be managed on the Course Form - Version History tab.</td>
</tr>
<tr>
<td>Begin</td>
<td>The date/time when this class session begins.</td>
</tr>
<tr>
<td>End</td>
<td>The date/time when this class session ends.</td>
</tr>
<tr>
<td>Hours</td>
<td>The number of hours for this class session.</td>
</tr>
<tr>
<td>Automatic</td>
<td>A checkbox to choose whether to calculate the hours automatically or allow the hours to be entered manually.</td>
</tr>
<tr>
<td>Capacity</td>
<td>The maximum capacity (number of trainees) for this class session.</td>
</tr>
<tr>
<td>Location</td>
<td>The location where the training is held. Manage the values in this selection field using the menu item</td>
</tr>
</tbody>
</table>
The name of the Trainer for this Class Session. The initial value will be set when the course is selected based on the Default Trainer set for the course. You may also select another trainer that has been identified based on the "Trainer" checkbox on the Personnel form.

The sign-in sheet may be scanned and then saved as a .pdf file in the File Attachments area.

The amount of fixed costs for the class session. This may include room rental fees, trainer fees, or other fixed costs for the session.

This is the default cost for each student. This value will be set by default when adding a new student to the Enrolled Students list.

The Total Cost is calculated automatically by adding the Fixed Cost to the sum of the Student Costs.

Click the Class Roster button to open a class roster/sign-in sheet.

See Also

Enrolled Students
Add/Remove Students
Class Sessions List View

3.3.3.1 Enrolled Students

The Student List grid lists the personnel who have been added to the class session.

The number of confirmed seats appears in the upper right corner of the Student List. This includes all students in the list with status: Enrolled, Completed, Failed, or Pending. It does not include students with status: Cancelled, No Show, Wait-Listed, or Exempt.

Click the Add/Remove Student button to open the form for adding or removing students from this class session.

Select All Button
Click the Select All button to select all of the rows in the enrolled students grid. This option is helpful when you need to select all of the students to update their status at the same time.

**Set Status Button**

- Select one or more rows and then click the Set Status: Completed button to set an individual status to Completed. To set the status to a different values such as Enrolled, Cancelled, or Failed, drop down the arrow next to the button, and select the appropriate status value.
- You may set the status for all personnel to Complete at the same time by selecting all rows in the grid and then clicking the Set Status: Complete button. To select all rows in the grid, click the “Select All” button in the toolbar.
- Select or deselect multiple rows by holding down the ctrl key while clicking on each row.
- This button will open the Training Record form to set the status and completion details (as seen when adding a record on the Personnel Transcript tab).

**Context Menu**

You may also right-click on a row to access the context menu to set the status for an individual person.

**See Also**

Add/Remove Students

Class Session Form

**3.3.2 Add/Remove Students**

The Add/Remove Students form allows you to manage the students enrolled in a course. This form is opened by clicking on the Enroll Students button on the Class Session list view or the Add/Remove Students button on the Class Session form.
Add/Remove Students

**Header**

The header lists the course title, session dates, and capacity. A red warning message will appear in the header if you attempt to overbook the session by adding more personnel than the capacity limit.

**Search box**

Enter a name, number, login, group, or job role in the search box to search for personnel to add to the list. To add an entire Group, enter the name of the group in the search box to filter the list. Then select all members of the group and move them to the selected students list on the right.

**List Views**

The list view on the left is the "source" which contains all active personnel. You can select and move students to the list view on the right to enroll them in the class session.

**Arrow buttons**

Click the Arrow buttons to move the personnel between the two lists, or double-click on a row to move it to the other list.

**Add from list**

Add several personnel at once using the "Add from list" drop down.

<table>
<thead>
<tr>
<th>List Option</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned Personnel</td>
<td>Select this option to add all Assigned personnel to</td>
</tr>
<tr>
<td>Filter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overdue Personnel</td>
<td>Select this option to add all Overdue personnel to the list.</td>
</tr>
<tr>
<td>Personnel Due In 30 Days</td>
<td>Select this option to add personnel with an Assignment coming due within 30 days.</td>
</tr>
<tr>
<td>Personnel Due In 60 Days</td>
<td>Select this option to add personnel with an Assignment coming due within 60 days.</td>
</tr>
</tbody>
</table>

**Hints**

- Narrow down the list of students to select quickly by typing a name, number, login, group, or job role in the filter box located above the list on the left.
- Select all personnel in the list of students by highlighting one of the rows and then pressing Ctrl + A.
- Select multiple rows individually by holding down the Ctrl key while clicking on rows.

**See Also**

Enrolled Students

### 3.4 Personnel

Personnel records contain the details for all Personnel including employees and trainers. For complete details, see the following sections:

- Personnel List View
- Personnel Form

#### 3.4.1 Personnel List View

The **Personnel List View** displays a list of the personnel records that have been stored in the database.

**Filters:**

- Active: Show only personnel with a status of Active in the list view.
- Inactive: Show only personnel with a status of Inactive in the list view.
- All: Show all personnel in the list view.

**Quick Search:**
Enter a few characters of the person's name, number, group, or job role in the Search box near the upper right to quickly filter the list.

**Toolbar Buttons:**

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Personnel</td>
<td>Opens a new Personnel form. Use this form to add new employees or trainers to the database.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the currently selected (highlighted row) personnel.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the currently selected personnel.</td>
</tr>
<tr>
<td>Export</td>
<td>Opens the Export Data dialog box to allow you to export the list of Personnel to a .csv file.</td>
</tr>
</tbody>
</table>

**Sorting:**
Click on a column header to sort the data by that column. Click again to re-sort the column in the opposite direction.

**Show Columns:**
Right-click anywhere on the list to display the context menu, then select "Show Columns" to select which columns you would like to display in the list.

### 3.4.2 Personnel Form

The **Personnel form** is used to manage the details for each person in the database.
Fields and Form Elements

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The first and last names of the person.</td>
</tr>
<tr>
<td>Login Name</td>
<td>The login name is the name that a user enters to login to the application. If the user will not have a login name, you may set this field blank.</td>
</tr>
<tr>
<td>Set Password (button)</td>
<td>System Administrators may click this button to set a user's password.</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Select the name of the Supervisor for this person. The list of names in this selection field is managed by checking the &quot;Supervisor&quot; checkbox.</td>
</tr>
<tr>
<td>Group</td>
<td>The Group selection field is the name of the Personnel Group that the person belongs to. You may select an existing Group or enter a new one.</td>
</tr>
<tr>
<td>Phone</td>
<td>[Optional] The phone number field is used to track the personnel's phone number.</td>
</tr>
<tr>
<td>Email</td>
<td>The Email field is used when sending a Class Session reminder from the Class Session list.</td>
</tr>
</tbody>
</table>
### Personnel Number

The Personnel Number field is a unique identifier for the personnel record.

### Automatic/Manual

You may select Automatic to have Training Manager assign a personnel number, or select Manual to manually enter a personnel number.

### Supervisor (checkbox)

Check the box if the person is a Supervisor. Supervisors will appear in the Supervisor selection field on the Personnel form.

### Trainer (checkbox)

Check the box if the person is a Trainer. Trainers will appear in the Trainer selection field on the Course form and the Class Session form.

### Exclude from required training (checkbox)

Check the box to exclude this person from required training Assignments. For example, if this person is an outside consultant or external trainer, you may want to exclude them from required training so that they won't be listed as "Overdue" on the training status reports.

### Picture

Click the Browse button to select an employee picture. To remove a picture, click the Clear button. You may click on the picture to open it in another window.

### Employment Status

Active/Inactive: set the status to Inactive when an employee no longer works for the company but you need to maintain their past training records. The person will no longer appear in the selection fields for new class sessions; however, there training records will still be available for lookup if needed.

### Date of hire

The Date of hire can be used when setting up required training (eg. Initial Training due: Date of Hire + 30 Days).

### Classification

Select the classification for the personnel.

### Notes

Miscellaneous notes may be entered in the Notes field.

You can add links to files using the file protocol. Example: `<file:///[Path to file]>`

### Job Roles

Each person may belong to zero or many Job Roles. This field is used in Job Role Assignments (eg. All Managers must take the Course "Managing Change" every 3 years).

### System Roles

Each person may belong to zero or many System Roles.

- **System Administrator**: Full Access to the Training Manager database, including login/password management.
- **Training Records Administrator**: Full Access to the Training Manager data records, excluding login/password management.
- **No System Role selected**: View only access to the Training Manager database (if the user has a
login/password).

### Permissions Matrix

<table>
<thead>
<tr>
<th>Permission</th>
<th>System Administrator</th>
<th>Training Records Administrator</th>
<th>No role assigned</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can view all records</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can insert/edit/delete Courses</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Can insert /edit/delete Class Sessions</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Can insert /edit/delete Personnel</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Can insert /edit/delete Assignments</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Can change other users passwords</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Can change login accounts</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Can assign system roles to a user</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Can manage the audit trail.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

### See Also

- Transcript
- Assignments
- Attachments

#### 3.4.2.1 Transcript

The Transcript tab is located on the Personnel Form. It contains a complete listing of all class sessions the person has completed, cancelled, or failed.
New Record Button

- Click the **New Record** button to add a new transcript entry. The new entry will appear in the Transcript list and the Transcript report. If the new record satisfies a training requirement, the Status will be updated on the Required Training report.
- If a Class Session doesn't already exist for this date, a new Class Session will automatically be created for this entry. If a Class Session already exists for this date, the entry will be added to the existing Class Session.
- Click the Session ID hyperlink to open the related Class Session record.
### Status field

Status values may be set to any of the values shown in the table below:

<table>
<thead>
<tr>
<th>Status Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed</td>
<td>The Class Session is over, and the student has satisfactorily completed the course requirements necessary to be granted credit for the course.</td>
</tr>
<tr>
<td>Exempt</td>
<td>The student did not attend a training session, but they are Exempt from any training requirements for the selected version of the course and the date selected. The exemption will expire based on the date of the exemption and the Assignment criteria. For example, if the course is required every year, the Exemption will be good for one year. Additional exemptions can be granted as needed.</td>
</tr>
<tr>
<td>Enrolled</td>
<td>The student is enrolled to attend the scheduled class session.</td>
</tr>
<tr>
<td>Pending</td>
<td>The student has attended the class session, but credit is pending an assessment such as a quiz, test, hands-on demonstration, or other activity to be completed before credit will be granted for the course.</td>
</tr>
<tr>
<td>Wait-Listed</td>
<td>The student is not yet enrolled in the class session due to space restrictions or other reasons.</td>
</tr>
<tr>
<td>Failed</td>
<td>The student attended the class session but did not meet the required standards to be given credit for successful completion.</td>
</tr>
</tbody>
</table>
Cancelled  The student cancelled before the class session was held.

No Show  The student did not attend the class session and did not cancel before the class session was held.

**Preview Report Button**

Click the Preview Report button to open this person's Transcript report.

**Export Button**

Click the Export button to export this person's Transcript data in .csv format.

3.4.2.2 **Assignments**

The Assignment tab on the Personnel form displays all types of Assignments that apply to this person.

<table>
<thead>
<tr>
<th>Course Title</th>
<th>Course Number</th>
<th>Type</th>
<th>Name</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration of instruments</td>
<td>CRS0000002</td>
<td>Group</td>
<td>Administration</td>
<td>When version changes</td>
</tr>
<tr>
<td>Managing change in the workplace</td>
<td>CRS0000001</td>
<td>Job</td>
<td>Manager</td>
<td>Every 1 Years</td>
</tr>
<tr>
<td>New Hire Orientation</td>
<td>CRS0000004</td>
<td>Group</td>
<td>All Groups</td>
<td>One time only</td>
</tr>
</tbody>
</table>

Assignments on the Personnel Form

**New Assignment Button**

Click the New Assignment button to add a new Individual Assignment. Note that the Assignment type and Personnel selection fields are both disabled in this view. Group and Job Role Assignments can be edited on the main Assignments tab.
For more information about the Assignments, see the main Assignments section.

**Preview Report Button**

Click the Preview Report button to open the Required Training report for this person.

**Export Button**

Click the Export button to export the Assignments for this person to a .csv file.

**3.4.2.3 Attachments**

The Attachments tab on the Personnel Form can be used to store any type of attachment.
Add File

Click the **Add File** button in the toolbar to add a new Attachment to the attachments list.

Open File

Click the **Open File** button in the toolbar to open the selected file in the attachments list. You may also double-click a file in the list to open it.

Save File

Click the **Save File** button in the toolbar to save the selected file to another location.

Delete File

Click the **Delete File** button in the toolbar to delete the selected file from the database.

3.5 Assignments

Assignments allow you to set up a matrix of required training for your organization. Here are a few examples:

1. "All Groups" must take "New Hire Orientation" training within 30 days from their hire date.
2. Members of the "Engineering" Group must be trained on the "Calibration" course whenever the version changes.
3. Members of the "Manager" Job Role must be trained on the "Managing Change in the Workplace" course once every 2 years.

As new personnel are added to Personnel Groups or Job Roles, they will automatically inherit the required training assignments for their Group and/or Job Roles. By assigning courses to a Group or Job Role, you can avoid the tedious management of individual courses to personnel, and focus on the overall training needs for the organization. For special cases however, you may still assign a course to a specific individual if needed.

Assignments will impact the Required Training and Status reports. The Overdue and Upcoming Status
The report may be filtered to show courses which are Overdue or upcoming in the next 30 days (or X days where you set the filter value). This allows you to identify all training that is about to expire so that it can be scheduled and the personnel can be notified. The status displayed on the report will be updated when training has been completed.

**See Also**

- Assignments List View
- Assignments Form
- Required Training Status
- Screencast: How To Create And Use Assignments

### 3.5.1 Assignments List View

The **Assignments List View** displays a list of the Assignments that have been stored in the database.

![Assignments List View](image)

**About Assignments**

You may create assignments on the Assignments tab which will automatically assign required training to individuals based on the settings you have chosen. There are three types of Assignments which you may create on the Assignments tab: Group, Job, and Individual. When a user has been assigned a course, it is "required", and it will show up on their status report as either "Untrained", "Overdue" or "Up to date".

**Group Assignments:**

If you create a Group assignment, it will be automatically assigned to everyone in the chosen group. When new people are added to the group, they will also have that assignment automatically set up for them. You may also choose "All Groups" if you have an assignment which you want to be added for everyone.

**Job Assignments:**

Job Assignments are similar to Group assignments, except that they are applied to everyone within a particular Job Role rather than people within a particular organizational group.
**Individual Assignments:**
You may use Individual assignments for one-off specific requirements for an individual person.

**More Details**

When a course is Assigned, the status will be "Overdue" until it has been completed per the criteria in the Assignment or it will be "Untrained" if it is within the specified grace period (if any) and has not yet been completed. The Assignments mean that the Course is absolutely "Required". The Status for a Required course will not be "Up To Date" until it has been completed. For example, if a course is required every year, but it has never been taken and is within the grace period specified on the Assignment, the status will be set to "Untrained". If it was previously completed, but has not been taken within the past 12 months or has never been taken and is past the grace period, then it will be "Overdue". If it has been taken at any time within the past 12 months, then the status will be "Up To Date".

The Overdue and Upcoming Status report displays all records that are either Untrained, Overdue or with an expiration date within the next X days. Scheduling a Class Session within X days will not have an impact on the Status. Only completing the Course will change the status. For example, consider the following cases:

**Case 1:**
Assignment: Course required once / year.
Last completed: 1/1/2012
Expiration Date: 1/1/2013
Status: This course is "Overdue" because the expiration date is in the past (1/1/2013).
If you add a "Completed" training record before the expiration date, the status will then be "Up To Date", and the new Expiration Date will be set for 1 year after the new completion date.

**Case 2:**
Assignment: Course required once every 3 years.
Last Completed: 1/1/2013
Expiration Date: 1/1/2016
Status: This course is "Up To Date" because it was last completed on 1/1/2013, and it doesn't expire until 1/1/2016.
If you have set the filter to only show courses with an expiration date within 30 days, this record will not be included on the report (because the expiration date is greater than 30 days from the current date).

**See Also**

Assignments Form

3.5.2 Assignment Form

Add and edit Assignments (training requirements) on the Assignment form.
Scope
Assignments may be assigned to a Group, Job Role, or an Individual. Select the appropriate type from the list.

Group/Job Role/Individual
Based on the Type selection, you may select All Groups, a specific Group, a Job Role, or a specific Individual. For the Group selection, you can choose to include the Subgroups by placing a check mark in the checkbox. To choose the selected Group only, remove the check mark. Click the Find button to the right of the selection field to search Groups with a hierarchy display format.

Course
Select the Course to be assigned.

Initial Training
Initial Training may be due immediately, based on the hire date (eg. Hire Date + 30 Days), or based on a specific date. You may also set a grace period to allow new hires time to take the training.

Retraining Requirement
The Assignment may be set to be required:

- One time only:
Use this setting for a course such as New Hire Training which only needs to be complete once.

- **Every X Days, Weeks, Years:**
  Use this setting for a course which needs to be repeated on a regular basis such as every year. The next training date will be based on when the training was last completed. For example, if you set the requirement to "Repeat Every 1 year", and a person has last completed the training on January 31, **2013** it will be due again for this person on January 31, **2014**.

- **When the course version changes:**
  Use this setting for job related courses which require retraining whenever the Course version changes. This option can be used when procedure changes are used to trigger Course version updates. For example, if you have a retraining requirement for a course set to "When course version changes", and then a related document has been updated, you may add a new course version on the Course Form. On the date when this course version becomes effective, all personnel who are required to take the course based on this assignment will appear as "Overdue" on the required training reports until they have completed training for the new version.

### See Also

Assignments List

#### 3.5.3 Required Training Status

Assignments are used to set up the "Required Training" for an organization. The "Status" of the required training will be based on the Assignment criteria and the completed training history.

### Required Training Status Notes

1. If the assignment has the option set for the Initial training to be due after a 30 day grace period, then it will not appear as "Overdue" until 30 days after the Hire Date set on the personnel form.
2. If none of the Course Versions listed on the Course form have the "Required" checkbox checked, then the course will not appear "Overdue" for anyone.
3. If the Employment Status field on the personnel form is set to "Inactive", the person will not appear on the Status reports.
4. If the "Exclude from required training" checkbox is checked on the personnel form, then the person will not appear on the Status reports.

### Status Values

1. **"Up To Date"** means that the training has been completed and is up to date based on the Assignment criteria.
2. **"Untrained"** means that the training has not yet been completed, but it is not "Overdue" yet because the time limit is still within the defined grace period. In this case, the person is not yet out of compliance with the requirement (since there is a grace period defined), and the record will not be counted as Overdue on the compliance report. If you would like it to be counted as overdue immediately and therefore out of compliance on the report, you may remove the grace period from the Assignment.
3. **"Overdue"** means that the person has not completed the required training as defined in the Assignment criteria. Depending on the Assignment details, training can expire based on the elapsed time since the last training was completed, or a newer required course version has become effective.
3.6 Reports

Training Manager comes with several built-in reports to provide training information for your organization, and to help plan for upcoming training requirements.

- Select a report on the left to preview it in the report preview area.
- Click on the report preview to zoom in or out.
- Standard filters are available above the report.
  - Personnel: Show All Active Personnel, or filter for an individual.
  - Groups: Show All Groups, or filter for a specific Group.
  - Include Subgroups: Check the box to include all personnel in sub groups of the selected Group.
  - Courses: Include all Courses, or filter by a specific course.
- Some reports allow additional filters to be applied. Additional filters will appear below the report selection area when available.
- Filter by date: Select from the pre-defined list of dates, or set the beginning and end date.
- Filter by days until expiration: Include training due to expire within the number of days that you set.
- Open In New Window button: Open the selected report in a new window which contains additional menu options including Export formats and an Email option.
- Print button: Send the selected report to the printer.
- Refresh button: Click to refresh the report if you have added or updated data since the report was last previewed.
**Company Name On Report**

Click the Options button in the toolbar to edit the existing header/footer and enter your own company name to appear on the reports.

**See Also**

Report Details

### 3.6.1 Report Details

**Master Data Reports**

**Personnel List By Group:**
This report displays a list of all active personnel in the database grouped by Personnel Group and sorted by Personnel Name.

**Personnel List By Job Role:**
This report displays a list of all active personnel in the database grouped by Job Role and sorted by Personnel Name.

**Training Reports**

**Training Transcript:**
This report displays a list of training records for each person grouped by status (Completed, Enrolled, Cancelled, Failed, No Show).

**Completed Training By Course:**
This report displays a list of Completed training records grouped by Course.

**Completed Training List:**
This report displays a list of all Completed training without any grouping.

**Required Training By Person:**
This report displays a list of all required training grouped first by Person and then by Assignment type. The required training records are those records which meet the criteria set in the Assignments created on the Assignments tab.

**Required Training By Course:**
This report displays a list of all required training grouped by Course. The required training records are those records which meet the criteria set in the Assignments created on the Assignments tab.

**Required Training By Group:**
This report displays a list of all required training grouped by Personnel Group. The required training records are those records which meet the criteria set in the Assignments created on the Assignments tab. For each Personnel Group, all Assignment Types (Group, Job Role, Individual) are displayed. This report can be used to identify all of the training needs for all or a specific group.

**Required Training By Supervisor:**
This report displays a list of all required training grouped by Supervisor. Within each group, all Assignment Types (Group, Job Role, Individual) are displayed. This report can be used to identify all of the training needs for the direct reports for all or a specific supervisor.
Training Assignments By Job Role:
This report displays a list of Training Assignments grouped by Job Role. This report contains only those records for which the Assignment is of type Job Role.

Training Assignments By Group:
This report displays a list of Training Assignments grouped by Personnel Group. This report contains only those records for which the Assignment is of type Group.

Training Costs:
This report displays a list of Training Costs. You can set additional report options for Grouping and Summary/Detail.

Overdue and Upcoming Status:
This report displays a list of required training which is Overdue or Upcoming (about to expire). The date filter below the report selection area is used to set the number of days until expiration to be included on the report.

Class Session List:
This report displays a list of all Class Sessions that meet the criteria set in the date filter.

Class Session Details:
This report displays a list of all Class Sessions and the enrolled students who were in the session. The report is filtered by date.

4 System Administration

Select a System Administration topic below:

- Firebird Database Server
- Troubleshoot Connections
- Schedule Daily Database Backup
- Update The Client Software
- Upgrade To Multi-User
- Technical Details
- Move To A New Computer
- Move database to new server
- Configure Email Client
- Audit Trail

Advanced Configuration:

- Command Line Options
- Citrix/Terminal Server Configuration
- File Locations
- Change the port number
- Multiple Databases Per Server
- Multiple Firebird Instances
- ODBC Connections

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition does not have the remote database feature available.
4.1 Firebird Database Server

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition not have the remote database feature available.

Network Setup Overview

When you install the Training Manager client software on your computer, an embedded database is installed by default to allow you to try out the software without further configuration. However, when you're ready to share the software on a network with multiple users, you need to install a shared database on a server. Any Windows computer may act as the database server, as long as it is accessible from all of the computers which need to access the shared database. You also want to make sure the computer is able to run without interruption to avoid any potential for database corruption which might occur if the computer is restarted while users are connecting to and using the database.

There are three basic configurations to choose from. Click on a diagram below to view full size:

Configuration Instructions

Each of the configurations require three basic steps:

1. Install the client software on the computers which will run Training Manager.
2. Install the database server software on a shared Windows server.
3. Connect the client computers to the database server.

You may watch a 3 minute instructional video, or follow the steps below:

Step 1: Install the Training Manager client software on the PCs

The client software is the program that users interact with to enter and update training records. If you have used the trial version of Training Manager, then you have already installed at least one copy of this software. This software is available for download at:

http://www.kzsoftware.com/products/training-manager/trial.htm

Note that in order to connect to a shared database server, you must install the Training Manager Enterprise Edition. All editions of Training Manager start in single user stand-alone mode by default. The Enterprise Edition can also connect to a remote central database server.
Step 2: Install the Firebird database software on the server

The database server software is very easy to install in the default configuration. To install in the default configuration, follow these steps:

- Log on to your server and download the setup program from: http://www.kzsoftware.com/products/kzfirebird/download.htm.
- Note that this is a different setup program than the one installed on the client computers.
- Run the setup program, and accept all defaults.
- This program will install a Firebird Database Server and a Training Manager database.

If you are using the Windows Firewall, configure it to allow Inbound TCP connections on Port 3050 as described below:

1. Open the Windows Firewall With Advanced Security: Start --> Search --> enter "firewall", and select the program "Windows Firewall With Advanced Security".
2. Select "Inbound Rules" in the left pane.
3. Click "New Rule" in the Actions pane on the right, and create a rule with the following settings:
   - Rule Type: Port
   - Protocol: TCP
   - Specific Port: 3050
   - Action: Allow the connection.
   - Profile: As required.
   - Name: Firebird

For Windows Server 2003 and 2000:
1. Open the Windows Firewall dialog: Start --> Run --> enter "firewall.cpl", and then click the Ok button.
2. Go to the Exceptions tab, and then click the Add Port button.
3. Enter a name such as "Firebird Database", and then enter the port number 3050, and click Ok.

Step 3: Connect the client computers to the shared database

After installing the database server, connect your client computer(s) to the shared database server by following these steps:

1. Open Training Manager on one of the client computers which it is installed on.
2. Select the menu option Tools --> Database Connection (Note: if you don't see this option, you need to install the "Enterprise Edition" with multiple user network support from: http://www.kzsoftware.com/products/training-manager/trial.htm)
3. Enter the name of the database server in the connection dialog box (if you don't know the name of the server, log on to the server and right-click "My Computer", choose "Properties", and then select the "Computer Name" tab.) Note that you only need to enter the name of the database server - you do not need to enter a file path when connecting to a remote database server. The file path is only required when connecting to a local database file.
4. Click Ok
5. Close and then reopen Training Manager. You're now connected to the shared database server.

Note: If you cannot connect to the database server, please see the following section: Troubleshooting Connections.
When you're finished configuring the database connection, set up a scheduled task to backup the database daily.

**Advanced - Citrix/Terminal Server Configuration:**

If you are installing the client on a Windows Terminal Server, please see the Citrix/Terminal Server Configuration Notes.

**Advanced - Database File Storage:**

If you are a server administrator and would like to change the default location where the Training Manager database is stored, you may do so by following the instructions below. Training Manager is designed to run with the standard options "out of the box", and in most cases there is no reason to change the defaults; however, these instructions are provided for server administrators who would like to change the default installation.

1. First stop the Firebird database service.
2. Next copy the database file from C:\KZSoftware\TrainingManager.tdb to the new location where you would like it to be stored. Note: the new location must be located on a hard drive that is physically connected to the host machine. It cannot be located on a mapped drive, a file system share, or a network file system.
3. Next, open the file C:\Program Files\firebird\aliases.config in notepad and change this line:
   TrainingManager=C:\KZSoftware\TrainingManager.tdb to reflect the new path to the database file.
4. Finally, restart the Firebird database service.
4.1.1 Client Server Configuration

Configuration: Standard Client Server

**Standard Client Server**

**Scenario:**
Single office environment with a database installed on a shared server and multiple users connected from separate desktop/laptop PCs.

**Role: Database Server**
Software: KZFirebird Database*
Other: Port 3050 open for TCP

*KZFirebird package includes Firebird 2.1.3, database files, and default configuration.

**Role: Client PCs**
OS: Windows XP, Vista, 7
Software: Client software - Enterprise/Network Edition**

Locally installed client software connects to the Firebird database over TCP port 3050. Use client menu option Tools → Database Connection to connect.

See Also

- Network Setup Overview
- Single Office: Shared Database on PC Configuration
- Multiple Offices: Terminal Server Configuration
4.1.2 Shared Database on PC

Configuration: Shared Database on PC (No Server)

On the PC which contains both the Firebird database software and the client software, use the menu option Tools --> Database Connection to set the database connection for multiple users and connect to "localhost". For all other PCs, set the database connection for multiple users and connect to the database by machine name or IP Address.

See Also

- Network Setup Overview
- Single Office: Client Server Configuration
- Multiple Offices: Terminal Server Configuration
4.1.3 Terminal Server Configuration

Configuration: Terminal Server

If you have installed both the Firebird database software and the client software on the same server, use the menu option Tools --> Database Connection to set the database connection for multiple users and connect to "localhost".

See Also
- Network Setup Overview
- Single Office: Shared Database on PC Configuration
- Single Office: Client Server Configuration

4.2 Troubleshoot Connections

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition not have the remote database feature available.

If you have completed the steps for installing the Firebird database and are experiencing problems connecting to the database, check the error message description and then locate it in the table below for troubleshooting steps:

<table>
<thead>
<tr>
<th>Connection Error</th>
<th>Potential Causes</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to complete network</td>
<td>1. The server name or IP Address</td>
<td>Step 1: Click the &quot;Ping&quot; button.</td>
</tr>
</tbody>
</table>
### Request to host [hostname].

1. The database file is in use by another application and is locked.

<table>
<thead>
<tr>
<th>No connection could be made because the target machine actively refused it.</th>
<th>The Firebird service is not running on the server.</th>
<th>The results are: &quot;Ping Failed&quot;, then the problem is Cause #1 to the left. Verify the server name or IP Address with your server administrator, and confirm that it is accessible on the network.</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Error for file &quot;Training Manager&quot; Error while trying to open file</td>
<td>1. If another application has the database opened in single user mode, close the application or connect in multi-user mode to</td>
<td>1. Start the Firebird service in Windows Control Panel --&gt; Administrative Tools --&gt; Services. If the Firebird service is not listed there, install the KZFiredbirdServer package as described in the shared database configuration instructions. If you have run the KZFiredbirdServer installer, but the service is not displayed or will not run, an anti-virus software may have interfered with the installation. Temporarily disable any anti-virus software and install KZFiredbirdServer again.</td>
</tr>
<tr>
<td>Your user name and password are not defined. Ask your database administrator to set up a Firebird login.</td>
<td>The value entered in the SYSDBA password field does not match the SYSDBA password on the Firebird server. Note: The SYSDBA password is used by the database server. It is not the same as the application passwords that have been set up for personnel to login to the client software. Leave the setting as the default value unless it has been changed on the server.</td>
<td>If the Firebird administrator has changed the SYSDBA password for the Firebird database, request the password or have the administrator enter the password for you in the SYSDBA Password field. If the SYSDBA password has not been changed, there may be another instance of Firebird running on the server with a different SYSDBA password. See the multi-instance configuration instructions in the user guide.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Unsuccessful execution caused by a system error that precludes successful execution of subsequent statements. I/O error for file &quot;SharedDocs\security2.fdb&quot;. Error while trying to open file. The system cannot find the path specified.</td>
<td>This message may appear when attempting to use the database from a file share. A database being accessed through a file share is subject to data corruption. Firebird is designed to run in client-server configuration for multiple users.</td>
<td>Install and connect to Firebird as described in the Shared Database Configuration instructions.</td>
</tr>
<tr>
<td>Any other error message not listed above.</td>
<td>Unknown</td>
<td>Check each of the items listed below and then try again. If the error persists, contact your database administrator.</td>
</tr>
</tbody>
</table>

2. The database port is in use by another instance of Firebird or other service.
3. The Database Alias name entered on the Advanced tab was not found on the Firebird server.
4. The database file is not in the location on the server specified in aliases.conf.

2. If multiple instances of Firebird are configured to use the same port, update one of the instances to use a different port number. See the following topic: Multiple Firebird Instances.
3. Check the alias name listed on the Advanced tab. It should be "TrainingManager" (no spaces) unless it has been manually set to a different value in the aliases.conf file on the server.
4. Use Notepad to open the aliases.conf file in the Firebird installation directory. Confirm that an entry exists for the alias name you have entered in the Database Alias field on the Advanced tab and that the file path to the database is correct.
Check the Windows firewall

The Windows firewall is a frequent cause for not being able to connect to the server. Make sure port 3050 is available for Inbound TCP connections on the server. Here are the steps:

For Windows 2003 and earlier:
1. Open the Windows Firewall dialog: Start --> Run --> enter "firewall.cpl", and then click the Ok button.
2. Go to the Exceptions tab, and then click the Add Port button.
3. Enter a name such as "Firebird Database", and then enter the port number 3050, and click Ok.

For Windows 2008 and later:
1. Open the Windows Firewall With Advanced Security: Start --> Search --> enter "firewall", and select the program "Windows Firewall With Advanced Security".
2. Select "Inbound Rules" in the left pane.
3. Click "New Rule" in the Actions pane on the right, and create a rule with the following settings:
   - Rule Type: Port
   - Protocol: TCP
   - Specific Port: 3050
   - Action: Allow the connection.
   - Profile: As required.
   - Name: Firebird

Check the Firebird database process

If you have already configured the firewall and are still unable to connect, please check to see if the Firebird database process is running on your server.

1. Open the Windows Task Manager: Start --> Run --> enter "taskmgr", and then click the Ok button.
2. Go to the processes tab, and make sure the checkbox for show processes for all users is checked.
3. Sort the processes by clicking on the Image Name column header and look for a process named fb_inet_server.exe (if running the default Firebird Classic), or fbserver.exe (if running Firebird Super Server).
4. If the process is not there, please install the Firebird Server.

Confirm the database connection setting

If you have configured the Firewall and the database process is running, confirm that the database connection setting on the client is correct.

- Log in to the Enterprise client, and go to Tools --> Database Connection.
- Confirm that the bottom radio button is selected for a multi-user database. If the top radio button is selected, only a single user will be able to access the database - the database will be locked and an I/O error will occur for subsequent connection attempts.
- Confirm that the name of the database server is entered correctly. It should be the name only, no slashes, file paths, etc. To find the name of your database server, log on to the server and then right-click "My Computer", choose "Properties", and then select the "Computer Name" tab. If the DNS is not resolving the computer name correctly, you may need to use the IP Address instead.

If the problem continues, there may be an anti-virus or other security software blocking the process on
the server.

**Check firebird.log for errors**

Log in to the server, and check the firebird.log file in the Program Files \ Firebird directory for errors.

You may see an error such as the following: "INET/inet_error: select in packet_receive errno = 10038"

--> This error indicates that the Firebird server process cannot operate correctly due to network interference which may be caused by an anti-virus or other security software blocking it. Check your security software and exclude the Firebird process or temporarily disable the security to test the connection again.

inet server err: setting **KEEPALIVE** socket option or inet server err: setting **NODELAY** socket option

--> This error may indicate that you need to use the "SuperServer" version of Firebird instead of the "Classic" version. You can download the SuperServer version [here](#).

4.3 **Schedule Database Backup**

Note: the remote database features described in this section are for the Enterprise Edition only. The Standard Edition does not have the remote database feature available.

You can set an automated schedule for backing up a server based database every day using the Windows Scheduled Tasks utility. For convenience, batch files are included in the Firebird bin directory to create the scheduled tasks and to backup the database.

**Automatic Configuration of the Scheduled Tasks**

Use these steps to create a Windows scheduled task on your server to automatically backup your database.

1. Locate the batch file on your server at: *C:\Program Files\Firebird\KZFirebird\bin\ScheduleTMBackup.bat*
2. Double-click the batch file to run it. If you get an Access Denied message, right-click on the file and choose "Run as Administrator".

*The Firebird directory may be in the "Program Files" or "Program Files (x86)" directory. If the batch file does not exist on your server, perform the manual configuration described in the next section.

**Important:** Run the scheduled task to test it as described below the next section and confirm that the database backup file is created as expected.

**Manual Configuration of the Scheduled Tasks**

Follow these steps to configure the scheduled task manually only if your installation does not contain the "ScheduleTMBackup.bat" file, or the automatic configuration was not successful. If your scheduled task has already been created, skip to the next section to test it.

1. Download the backup batch file - right-click on the link below and select "Save Target As" or "Save Link As".
   **Batch File:** [Backup Training Manager](#)
2. Save the file to the Firebird bin directory at: *C:\Program Files\Firebird\KZFirebird\bin*
   The batch file must be located in the bin directory which contains the gbak utility.
Windows 2008/2012/2016:

In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Task Scheduler - or - Start --> Run --> control.exe schedtasks
Click the "Create Task" link in the Actions pane on the right side of the window, and then set the following:

General Tab:
Enter a Name: Backup Training Manager
Enter a description: Backup the training manager database
Select "Run whether user is logged on or not"

Triggers Tab:
Add a new trigger to run the task Daily.

Action Tab:
Add a new Action to "Start a program". 
Select the BackupTrainingManager.bat file which you have previously saved in the KZFirebird\bin directory.

Windows 2000/2003:

1. In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Scheduled Tasks 
   - or - Start --> Run --> control.exe schedtasks
2. Click "Add a scheduled task"
3. Click "Next"
4. Click "Browse..." and then select the batch file you downloaded in Step 1.
5. Select the radio button to perform this task "Daily"
6. Click "Next"
7. Select a start time and then click the "Next" button.
8. Enter the user name and password for the Windows account which will be used to execute the task, and then click the "Next" button.
9. Click the "Finish" button.

Important: Run the scheduled task to test it as described below and confirm that the database backup file is created as expected.

Run the scheduled task and confirm the operation.

- In Windows, go to Start --> All Programs --> Accessories --> System Tools --> Task Scheduler 
  - or - Start --> Run --> control.exe schedtasks
- Right-click on the scheduled task you created and select "Run".
- A console window will open and execute the command automatically before closing.
- After the window closes, confirm that a backup file has been created in the folder at C:\Backup.
- The backup file will be compressed, and may be much smaller than the uncompressed database file.
- If the backup file is not created, open the batch file in Notepad, and confirm/update the file path to the gbak utility if needed.
- When finished, log off the computer and allow the backup task to run at it's scheduled time, and then confirm that a new file has been created when the task ran as scheduled.
- After you have confirmed that the backup file is being created as expected, be sure to update your organization's disaster recovery preparedness procedures to include the system information. A
good plan will include a schedule to periodically audit the process and test a database recovery on a separate test system.

**More information about the batch file**

- By default, the batch file will keep the 10 most recent backups of your database.
- On the 11th day, the oldest backup file will be replaced with the current backup file.
- Backup files are named using the database name plus a number at the end. The most recent backup file ends with the number 1. The oldest backup file ends with the number 10.
- The default backup location is at C:\Backup.
- The default number of copies to keep and the default backup location may be changed by editing the batch file in Notepad.
- Right click on the batch file and select "Edit" to make changes.
- Change only the values listed in the SET statements at the top of the batch file.
- Make only one change at a time, and test between each change to aid troubleshooting if necessary.

### 4.4 Update The Client Software

**Client Software Updates**

As new releases become available, you may update the Training Manager software as follows:

1. Make sure no one else is using the database (all other users should have Training Manager completely closed).
2. Make a backup of the database for safety (File --> Backup).
3. Use the menu option Help --> Check for updates, and follow the installation prompts, or if you are unable to connect to our update server, close Training Manager, and then install the current version of the software from our website. This will not overwrite your existing database.
4. After the update completes, open the software. If any database schema updates are required, a message will appear as shown below in the "Database Schema Updates" section. Wait until all updates have completed before any other users open the software.
5. Make sure all other users update their software to the same version to avoid any mismatched version conflicts.

You can find out more information about the changes in each update in the Product Updates section on our website.

Note: If your license is over 2 years old and you do not have a current support subscription, a 50% update charge may apply.

**Database Schema Updates**

Some updates to the software will also require an update to the database schema. When Training Manager is opened, it checks the database to see whether a schema update is required. If the database schema requires an update, the following message will appear:
When you are sure no one else has the software open, click **Yes**, and then wait while the database schema is automatically updated. It is important to allow the update to proceed without interruption to ensure the integrity of the update. The database could become corrupted if the update is interrupted by turning off the computer, or if another user attempts to login to the database while the schema update is taking place.

### Mismatched Versions

After a database schema update has taken place, all computers with the software installed should be updated to the same version. When a version of the software which was designed for an older database schema is used to connect to a newer database schema, the following message will appear when the software is opened:

In addition, an error message will appear when performing any function which requires the new database schema. To prevent the error messages, coordinate all updates so that all users are running the same version of the software.

### 4.5 Upgrade To Multi-User

If you start out with a standalone database on a single computer and then decide to change to a shared database for multiple computers, you can copy your existing data to the server so that you don't lose your previous work. The basic process is to create a backup file of your local database before the switch over, and then restore it to your new server database.

#### Steps to upgrade to multi-user

1. Backup your local database (menu option: File --> Backup). This will create a compressed backup file containing your data.
2. Install and configure the remote database server (to be performed by server administrator). See instructions here:
   [Shared Database Configuration](#)
3. Install the Enterprise edition of the client software on your computer if it is not currently installed. A link to install the client software is included in the instructions at the link above.
4. Connect to the remote database server (menu option: Tools --> Database Connection).
5. Restore your local database backup copy to the server (menu option: File --> Restore). Select the backup file that you created in Step 1, and then click the Restore button.
6. You can then install the Enterprise edition on additional user's computers and connect them to the remote database server (step 4).

Note: if you are currently licensed for a standalone version of the software only, you will need to purchase an upgrade license key to continue adding new data to the server database. Refer to the link in your original license notification email, or contact us through the Support page on our website at www.kzsoftware.com. Let us know what your current license number is, and we will provide you with a link to purchase an upgrade license.

4.6 Technical Details

System Requirements

The initial installation of the Firebird Server for your database will require 27 mb.
The normal rate of growth of the database file without file attachments is 1 MB per 7000 records.
Additionally, the Audit Trail will use approximately 10 MB per 10,000 records.
Pictures in the personnel records can be added at a rate of about 6 MB per 100 personnel.
If file attachments are added to records, the database will grow in size based on the size of the attachments.

Client:
- Required Disk Space: 90 mb
- Minimum CPU: 1 Ghz
- Operating System: Windows 7 or higher (7, 8, and 10) - 32 or 64 bit.
- Notes: The setup process will download and install the .NET Framework v 4.5.2 if it is not already installed.

Database Server:
- Required Disk Space: 27 mb for the Firebird server component.
- Minimum CPU: 1 Ghz
- Ports: The server must accept TCP connections on port 3050.
- Notes: KZFirebirdServer.exe will install the Firebird server v. 2.1.7 and the default database files. No additional components such as .NET or Java are required on the server.

Training Manager Database

- Training Manager stores all of the data and pictures in a single database file.
- Training Manager Database files have the file extension ".tdb".
- Training Manager backup files are compressed to save space and have the file extension ".tbk".
- Training Manager uses the open source Firebird database version 2.1.7 for data storage.
- The local database is stored at the following location:
  Windows XP (for older versions of the software): C:\Documents and Settings\All Users\Application Data\TrainingManager\TrainingManager.tdb
  Windows 7, 8, and 10: C:\Program Data\TrainingManager\Training Manager.tdb
- The remote database is stored at the following location on the database server:
  C: \KZSoftware\TrainingManager.tdb
- Third-party applications can read the Training Manager database via ODBC. See additional information.
at the following link:
Firebird ODBC Connection.

Firebird Facts

Firebird in the Enterprise

Get to know Firebird
http://www.firebirdnews.org/docs/fb2min.html

4.7 Move To A New Computer

If you get a new computer or need to move the Standard (single user) Edition of Training Manager to another computer, you may do so as follows:

**On the Original computer:**

1. Go to the menu option Help --> Enter License Key, or Help --> About, and write down your license key and version number to use later.
2. Go to the menu option File --> Backup, and create a backup file.
3. Copy the backup file created in step 2 from the old computer to the new computer.

**On the New computer:**

4. Download and install the same edition and version of the software from the Software Archive, and then go to the menu item Help --> Enter License Key, and enter the license key number from Step 1.
5. Select the menu option File --> Restore, and then select the backup file that you copied over from the old computer.
6. Close and then reopen Training Manager.

4.8 Move Database To New Server

If you need to decommission an older server or move your database for another reason, you may move an existing database from one server to another by backing up the old database and restoring it to the new database as described below. Be sure to follow the steps carefully and check which database you are connected to when performing the restore operation in order to avoid overwriting your old database.

1. While connected to your ORIGINAL server, create a backup of the database using the Training Manager menu option File --> Backup. This will create a compressed backup file with the name and location that you choose.
2. Install the Firebird Database component on your NEW server. See Step 2 in the Firebird Database Server configuration instructions for details.
3. Connect Training Manager to the NEW server as described in Step 3 of the Firebird Database Server configuration instructions. Close and reopen Training Manager, and make sure you are connected to the NEW database.
4. Now restore the data to the NEW server from the backup file that you created in Step 1. Use the restore feature available in Training Manager from the menu item File --> Restore. Select the backup file that you created in Step 1, and then click the Restore button to overwrite the NEW database with the data from your backup file.
5. After you have completed restoring the data from your ORIGINAL server to your NEW server, make sure all computers which are using Training Manager have been updated to connect to the NEW
server (Tools --> Database Connection), and then shut down or remove the Firebird services from the original server to make sure no one mistakenly uses it.

4.9 Configure Email Client

When sending class session reminders or reports, Training Manager will attempt to open the email client which has been configured in Windows as the "Default" email client. You can designate which email client is the default one as follows:

**In Windows XP:**

1. Open Internet Explorer
2. Select Tools --> Internet Options from the menu.
3. Select the Programs tab.
4. Select your desired email client from the drop down list.
5. Click Ok.
6. To test your selection, click [this link](#) to see if it opens your desired email client.

**In Windows Vista, 7, and 8:**

1. Click Start.
2. Type “default programs” in the Start Search box.
3. Click Default Programs under Programs in the search results.
4. Click Set your default programs.
5. Highlight your desired email client on the left.
6. Click Set this program as default.
7. Click Ok.
8. To test your selection, click [this link](#) to see if it opens your desired email client.

**In Windows 10:**

1. Click on the Start menu button - lower left.
2. Click on the Settings menu item.
3. Click on the System icon.
4. Click on the Default Apps menu item.
5. Look for the Email heading, and click on the current default email client just below the heading.
6. Select your desired email client.
7. Close the Settings window.
8. To test your selection, click [this link](#) to see if it opens your desired email client.

Notes:
- The email addresses used for the reminders come from the "Email" field on the personnel form.
- You may need to restart Training Manager after making the changes to your default email client.

**Troubleshooting**

**Problem:**
I want to use Gmail for the email client, but it is not listed in the options for default email client.

**Solution:**
If Gmail is not listed as an option for a default email client in your version of Windows, you will need to install a 3rd party utility which can be set as the default and configured to send via email. Here is a link to a utility which provides that feature: Affixa

Problem:
When sending an email to a list of email addresses, a message indicates that the email addresses should be separated by semi-colons instead of commas. Note however, that a comma is designated to be used to separate email addresses in RFC Section 3.4 for Internet Message Format.

Solution:
Microsoft has acknowledged a bug for this issue in Outlook 2003 and Outlook 2007. Per their support page: "Status: Microsoft has confirmed that this is a problem in the Microsoft products that are listed at the beginning of this article." Microsoft has also provided the following solution:

Follow these steps to configure Outlook to recognize the comma as a valid e-mail address separator:

1. On the Tools menu, click Options.
2. Click E-Mail Options, and then click Advanced E-Mail Options.
3. Under When sending a message, click to select the Allow comma as address separator check box.

Note You can still use a semi-colon (;) to separate e-mail addresses when you click to select the Allow comma as address separator check box.

See the following Microsoft support article for the full details: http://support.microsoft.com/kb/820868

Problem:
When sending an email, the following message appears: "Either there is no default mail client or the current mail client cannot fulfill the messaging request".

Solution:
Set the default email client as described at the top of this page.

If the default email client has already been set, but the problem continues, the Outlook registry key may be corrupt. See the following article from Microsoft for solution details: http://support.microsoft.com/kb/813745

If the above solutions do not resolve the problem, check to see if the version of Outlook installed is 64 bit. There is no benefit in using the 64 bit version of Outlook, and it is not compatible with many applications. See this article for more information: http://www.msoutlook.info/question/461

4.10 Audit Trail

The Audit Trail keeps track of changes to the records in Training Manager. This log was implemented in version 1.0.1176, and it is turned on by default. Actions taken before the audit trail was implemented were not logged. It can only be turned off by a person in the "System Administrator" role. To turn the audit trail logging feature on or off, click the "Options" button on the Report tab, and then select the "Audit Trail" tab.

To view the Audit Trail, select the Audit Trail report on the main "Reports" tab. Use the date filters located below the report list to limit the time frame of the report, or filter by Source, Action, Record...
Type, or Person who made the change using the filter fields located above the report preview area.

You may also export the raw audit trail log data using the menu option Tools --> Export.

**Fields**

The Audit Trail report displays the following fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timestamp</td>
<td>The date/time when the record was changed displayed in local time.</td>
</tr>
<tr>
<td>Source</td>
<td>The source of the change.</td>
</tr>
<tr>
<td></td>
<td>• Data Entry: Changes made using the Training Manager data entry forms.</td>
</tr>
<tr>
<td></td>
<td>• Import: Changes made using the Training Manager import process.</td>
</tr>
<tr>
<td></td>
<td>• System Update: Changes made by a system update.</td>
</tr>
<tr>
<td>Action</td>
<td>The type of action which was taken.</td>
</tr>
<tr>
<td></td>
<td>• Add New: A new record was added to the database.</td>
</tr>
<tr>
<td></td>
<td>• Update: An existing record was updated in the database.</td>
</tr>
<tr>
<td></td>
<td>• Delete: A record in the database was deleted.</td>
</tr>
<tr>
<td></td>
<td>• Turn ON: The audit trail log was turned on.</td>
</tr>
<tr>
<td></td>
<td>• Turn OFF: The audit trail log was turned off.</td>
</tr>
<tr>
<td>Record Type</td>
<td>The type of record which was modified.</td>
</tr>
<tr>
<td></td>
<td>• Course: A master course record.</td>
</tr>
<tr>
<td></td>
<td>• Class Session: A class session record.</td>
</tr>
<tr>
<td></td>
<td>• Personnel: A master personnel record.</td>
</tr>
<tr>
<td></td>
<td>• Assignment: An assignment record.</td>
</tr>
<tr>
<td></td>
<td>• Audit Trail</td>
</tr>
<tr>
<td>Record Description</td>
<td>A brief description of the record to identify it.</td>
</tr>
<tr>
<td>Change Details</td>
<td>A description of the changes to the record such as:</td>
</tr>
<tr>
<td></td>
<td>• Initial values for new records.</td>
</tr>
<tr>
<td></td>
<td>• Changed values for updated records.</td>
</tr>
<tr>
<td></td>
<td>• Deleted values for deleted records.</td>
</tr>
<tr>
<td>Personnel</td>
<td>The name and number of the person who changed the record.</td>
</tr>
</tbody>
</table>

The audit trail records changes to the underlying database tables. As such, it’s possible that a single change in the Training Manager user interface may result in several entries in the audit trail. For example, if you delete 1 master course record in Training Manager, the audit trail will include an entry for that course deletion as well as entries for all related records which have been deleted or updated as a result of deleting a master record. Similarly, if you delete a personnel record, you will also see entries which show that the person has been removed from any class sessions they may have been enrolled in.
4.11 Advanced Configuration

Select a topic below:

- Command Line Options
- Citrix/Terminal Server Configuration
- File Locations
- Change the port number
- Multiple Databases Per Server
- Multiple Firebird Instances
- ODBC Connections

4.11.1 Command Line Options

**Client software command line parameters:**

//server [Server Name Or IP Address]
Specify the server name or ip address of the server where the Training Manager database is running.
Default: previously used server name.

//alias [Name of database alias]
Specify the name of the database alias to connect to.
Default: previously used alias name.

//userprofile [roaming]
Specify "roaming" to use a Roaming profile for User.config settings.
Default: Local User.config settings.

You may create a shortcut on the desktop, and then edit the shortcut properties to modify the target to include the parameters at the end.

Example Usage:
"C:\Program Files\Training Manager 2016 Enterprise\TrainingManager.exe" /server localhost /alias TrainingManager /userprofile roaming

**Installation (setup file) command line parameters:**

Options for the setup file can be set for unattended installations. For a complete list of setup command line parameters, please see the following link:

Setup command line parameters

4.11.2 Citrix/Terminal Server Configuration

If you have installed the client software on a Citrix/Terminal Server, you will need to manually configure the default database connection settings for new users. New user profiles will then use the database...
connection setting that you define rather than the default local file-based database connection. A server-based connection is required in order to have more than one user logged into the client at the same time. There are two options available for setting a default database server to connect to:

**Option 1: Set command line options in the user's shortcut.**

For details, please see the [Command Line Options](#) section in this User Guide.

**Option 2: Update the TrainingManager.exe.config file to specify the default value for new windows profiles.**

On the Terminal Server:

1) First, make a backup copy of the `TrainingManager.exe.config` file which is located in the `C:\Program Files\[Program Name]\` directory.

2) Next, open the `[Program Name].exe.config` file in Notepad, and make the changes as shown below. Copy the "New Values" section and then paste it over the similar sections in your config file to make sure it is exact. If the Firebird database is on a different server, replace "localhost" with the name of the server which hosts the Firebird database.

**OLD VALUES:**

```xml
<setting name="DBType" serializeAs="String">
  <value>FirebirdEmbedded</value>
</setting>

<setting name="RemoteDatabase" serializeAs="String">
  <value /></setting>
```

**NEW VALUES:**

```xml
<setting name="DBType" serializeAs="String">
  <value>FirebirdServer</value>
</setting>

<setting name="RemoteDatabase" serializeAs="String">
  <value>localhost</value>
</setting>
```

3) Save the changes and open the client to confirm the settings are correct.

Note: If you have already logged in with some other user accounts, make sure those profiles have the matching database settings set using the menu option Tools --> Database Connection (while logged in with the existing user account). The configuration above will set the default for all NEW profiles created (profiles are created the first time a user opens the application while logged on to the machine with their windows account).

You may also test your updates as follows:
After making the changes to the program config file as shown above, Delete the user.config file in the local user application data directory (see [File Locations](#)).
Open the application. It will load the application configuration and re-create the user.config file.

If the application displays an error message after making the changes, restore the backup of the program config file. If you do not have a backup of the program config file, delete it and then reinstall the application to restore the default version.

**Troubleshooting Errors in Citrix**

In some cases, when opening the software running on Citrix, an exception will occur with the message `system.nullreferenceexception`, and the screen may be blank or contain a large red 'X'. This can happen due to Windows not having a primary screen defined.

Conditions for not having a primary screen defined on Citrix server:

- Having a Citrix client using dual screen with primary screen set on the right,
- Having a cumulated resolution X colorDepth of client dual screen higher than the maximum video memory allowed on Citrix server per client.

Solutions for this problem include:

- In the display properties, change the primary screen to the one on the left.
- In the display properties, change the resolution to a lower value.

Note: You may need to close the Citrix session and login again after changing these values for the change to take place properly.

### 4.11.3 File Locations

Below is a listing of default file locations for Config, Database, and Log files for our software products. This information may be useful for special configurations or when diagnosing a connection error. In most cases you will not need to modify these files. If you decide to modify any of the files listed below, create a backup copy of the original file before changing it.

**Config Files**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Program Name].exe.config</td>
<td>Program Files[Program Name]</td>
<td>This file contains the default values that will be used to create the initial user.config file which in turn is used to store individual user preferences.</td>
</tr>
<tr>
<td>user.config</td>
<td>Local Users Application Data folder*</td>
<td>This file is created the first time a specific user opens the program, and it is updated as preferences are changed</td>
</tr>
<tr>
<td>aliases.conf</td>
<td>Program Files\Firebird (on the server)</td>
<td>This file is used by the Firebird server process to lookup the physical location of the database file.</td>
</tr>
</tbody>
</table>

**Database Files**
### Training Manager User Guide

#### File Name

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Program Name].tdb</td>
<td>All Users Application Data folder* (on the client)</td>
<td>This is the raw Firebird database file used by the embedded client.</td>
</tr>
<tr>
<td>[Program Name].tdb</td>
<td>C:\KZSoftware[Program Name].tdb (on the server)</td>
<td>This is the raw Firebird database file used by the Firebird server process.</td>
</tr>
</tbody>
</table>

#### Log Files

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>log.txt</td>
<td>All Users Application Data folder* (on the client)</td>
<td>This file contains the log of any application errors that occur on the client.</td>
</tr>
<tr>
<td>firebird.log</td>
<td>C:\Program Files\Firebird\firebird.log (on the server)</td>
<td>This file contains the log of any firebird database errors that occur on the server.</td>
</tr>
</tbody>
</table>

#### *System Defined Folders*

**Local Users Application Data Folder:**
The location of this folder varies according to the operating system:
- Windows XP: C:\Documents and Settings\[user account name]\Local Settings\Application Data\Kaizen_Software_Solutions\[Unique Program ID]
- Windows Vista, 7, 8, and 10: C:\Users\[user account name]\AppData\Local\Kaizen_Software_Solutions\[Unique Program ID]

You may also find this folder by typing %USERPROFILE% in the "Run" box (Windows XP), or the "Search" box (Windows Vista, 7, 8, and 10) and then drilling down into the appropriate folder.

Note: the location of the User.config file may be changed using a command line switch.

**All Users Application Data Folder:**
The location of this folder varies according to the operating system:
- Windows XP: C:\Documents and Settings\All Users\Application Data\[Program Name]\[database file]
- Windows Vista, 7, 8, and 10: C:\Program Data\[Program Name]\[database file]

You may also find this folder by typing %AllUsersProfile% in the "Run" box (Windows XP), or the "Search" box (Windows Vista, 7, 8, and 10) and then drilling down into the appropriate folder.

These folder locations are hidden by default, so you may need to show all files and folders in order to find them (My Computer --&gt; Tools --&gt; Folder Options --&gt; View tab --&gt; Show all files and folders).

#### 4.11.4 Change the port number

The default Firebird configuration listens for incoming connections on port 3050. If you are running only once instance of Firebird, then no changes are required. However, if you have multiple instances of Firebird running on one machine, then each one must listen on a different port. You can change the port that a given instance uses by modifying the firebird.conf file which is located in the Firebird directory for that instance.
Important Note: The information in this section is provided for advanced configuration only. In most cases, only one instance is required so the default port setting can be used and none of the changes listed in this section are needed.

**Set the port which Firebird uses**

To change the port from 3050 to 3051, open the file C:\Program Files\Firebird\KZFirebird\Firebird.conf in Notepad, and locate the line containing "RemoteServicePort". Then modify the setting as follows:

OLD: #RemoteServicePort = 3050  
NEW: RemoteServicePort = 3051

*(Remove the # sign and change the port number to 3051)*

After changing the port and saving the changes. Stop the Firebird service and then Start it again.

**Connect using the new port**

After changing the port number that the database listens on, you will need to update the port number that the client software connects to as follows:

1. Select the menu option Tools --> Database Connection.  
2. Select the "Advanced" tab.  
3. Uncheck the "Default" checkbox and set the Port to the new value.

4.11.5  **Multiple Databases Per Server**

[Enterprise Edition]: A database server can be configured to host multiple completely separate databases which can be identified with a unique name (Alias). You can choose which database to connect to by entering the name of the alias on the Advanced tab of the database connection form, or by setting up separate shortcuts for each database. See below for details:

Setting up the server:

1. First, install the Firebird database software and configure it for use with a single database as described in the shared database configuration instructions (if you haven't already).  
2. After successfully installing, configuring, and testing the shared database, close all connections to the database and then make a copy of the database file located in the directory C:\KZSoftware. Name this file to distinguish it from the other files as needed. For example, if this is a test database, you may name it: TrainingManagerTest.tdb.  
3. Lastly, use notepad to open the file "aliases.conf" (located in the Program Files \ Firebird directory), and add a new line containing the path to the new database file you created in Step 2, and an "Alias" name you will use to refer to this connection. Use the same format as the existing entries in the file. You may copy an existing entry and then paste it in at the bottom of the file and make changes to the alias name and database file path as needed. Be sure each database file has a unique alias name. In keeping with the "Test" database example, you might name the new alias, "TrainingManagerTest".

At this point, you should have already connected to the default alias from the client, and you can test the connection to the new alias as follows:

Connection to the new alias:
1. Open the client software, and select the menu item Tools --> Database Connection.
2. Select the "Advanced" tab, and change the "DB Name (Alias)" field to the name of the new Alias you created in Step 3 of the server setup.
3. You can now test the connection and then save it.

You can also set up multiple shortcuts to open the client with the specified database alias selected. For more information, please see the Command Line Options in the user guide at the following link:

Command Line Options

4.11.6 Multiple Firebird Instances

The Firebird database server supports the option to run multiple instances on one machine. Each instance can be given a name and run as a Windows Service. This may be needed if you have other applications which require you to run a different version of Firebird on your server.

The KZFirebirdServer installer has been updated to install a named instance as follows:

Instance Name: "KZFirebirdInstance"
Directory: C:\Program Files\Firebird\KZFirebird

It will appear in the list of Windows Services with the name, "Firebird Server - KZFirebirdInstance".

Windows Services with Firebird Server - KZFirebirdInstance highlighted.

If additional Firebird instances are installed, you will see the services listed with different names. A default Firebird installation which has not been given an instance name will appear with the name "Firebird Server - DefaultInstance".

To run multiple instances of Firebird, each instance must be configured to listen on a different port. For
details, see the topic: Change the port number.

4.11.7 ODBC Connections

ODBC Connection to Firebird Database

You may connect to Firebird databases using an ODBC Connection. This allows you to connect 3rd party database utilities (such as MS Access or Crystal Reports) directly to the database.

Important Notes:

- Perform read-only operations only, and make a backup of your database before attempting any direct database connections.
- Do not change the database schema or add new database views based on existing views. Future software updates may fail if a database view contains unexpected dependencies from a custom user-created database view.

An ODBC driver is available at the following links:

Firebird ODBC Driver (32 Bit Windows)
Firebird ODBC Driver (64 Bit Windows)

Or check this page on the Firebird website for updated drivers and additional support.

After installing a Firebird ODBC Driver, follow the steps below to create an ODBC connection.

Create an ODBC Connection in Windows

Step 1: Add a new data source using the Firebird driver in the Windows ODBC Data Source Administrator.
This control panel applet is available in Windows Administrative Tools.

**Step 2: Select your data source and then click the Configure button to configure the settings:**
Example Connection to a remote Training Manager database. For Asset Manager or Vehicle Manager, replace "Training" with "Asset" or "Vehicle".

Settings:

- **Database**:
  - For a local file database, select the database file (e.g. TrainingManager.tdb, VehicleData.vdb, or AssetManager.adb). In the file browser window, select "All Files" to remove the *.fdb filter from the file selection box.
  - For a remote database, enter the name of the server and the name of the database alias separated by a colon (no spaces).
- **Client**: Enter path to fbclient.dll. The fbclient.dll file can be found in the installation folder / odbc directory, or it can be downloaded here (FBClient2.1.7). Be sure to match the "bitness" (32 bit or 64 bit client).
- **Database Account**: SYSDBA
- **Password**: masterkey
- **Role**: [leave blank]
- **Extended Identifier properties**: quoted identifiers
- **Character Set**: UTF8
- **Dialect**: 3

**Firebird ODBC Connection Troubleshooting**

**Problem**: Cannot open database
Solution: Match 32 bit or 64 bit for all components:

1. ODBC Driver
2. ODBC Admin program
3. fbclient
4. Any 3rd party utilities such as MS Access, Crystal Reports, etc.

It gets confusing on 64 bit Windows 7 because there are two versions of the ODBC admin program. Oddly, the 32 bit version is stored in the SysWOW64 directory, while the 64 bit version is stored in the System32 directory:

- The 32-bit version of the Odbcad32.exe file is located in the %systemdrive%\Windows\SysWoW64 folder.
- The 64-bit version of the Odbcad32.exe file is located in the %systemdrive%\Windows\System32 folder.

Problem: “Tables not found” message in Crystal Reports.

Solution: Set the "Overidden Qualified Table Name" in the Properties for each table in the Crystal Reports set database dialog. Note that table names are case sensitive.

5 How To (Steps)

If you are just getting started, you may want to review the information in the Getting Started - Populate the data section.

- Add completed training
- Add company name and logo on report
- Set up annual training requirements
- Add an External Trainer
- Export a report
- Set or change a password
- Add a read-only or administrator user
- Manage the system (technical)

Additional details about individual areas of the software can be found in the Reference section.

5.1 Add completed training

When a student or students have completed training, it is important to set the Status to completed, and confirm the completion date in order for the status reports to accurately display the current training status. There are two options available for adding completed training:

Option 1: Several people were trained all on the same date

1. Open a new class session record on the class session tab by clicking the "New Session" button.
2. Fill in the session information on the left, and then click the "Add/Remove Students" button on the right to add the students who attended the session.
3. Select all of the students in the list view and click the Set Status: Complete button.
4. Save and Close the record - this will record the training for all of the students in the session at once.

Note: in option 1, transcript records will be created automatically based on the information in the class session record.

**Option 2: An individual completed training**

1. Open the personnel form for the individual and select the Transcript tab.
2. Click the New Transcript button, and set the Status field to complete.
3. Fill in the remaining information as needed, and then click "Ok" to save the record.

Note: in option 2, a class session record will be created automatically based on the information in the Transcript record.

**See Also**

- Enrolled Students
- Add/Remove Students

### 5.2 Add company name and logo on report

You can customize the report headers to include your company name and logo.

To list your company name and logo on reports:

1. Select the main "Reports" tab.
2. Click on the "Options" button in the toolbar located just above the report.
3. "Edit" the Custom Header/Footer to use your company name.
4. Make sure the checkbox is checked to include the Company Logo.
5. Select a logo on the Company Logo tab.

### 5.3 Set up annual training requirements

Training Requirements (sometimes referred to as a "Training Matrix") can be set up on the Assignments tab. Re-training requirements can be based on the last trained date or on a specific calendar schedule. See the information below for each option:

**Option 1 - Set the frequency to "Repeat every 1 year":**

A common option for annual training is to set the Frequency for the Assignment to repeat every 1 year. In this case, the next training date is based on when the training was last completed. For example, if someone completes the training on 4/15/2017, that person will be due for training again on 4/15/2018 (i.e. 1 year from the date of their last training). The next due date is based on the date set when the status is set to "Complete". This date may be set differently (or the same) for each person enrolled in a class session. The "Initial Due Date" for the Assignment does not impact the re-training date. The "Initial Due Date" is used to provide a grace period in order to prevent the status from immediately appearing as "Overdue" for a new Assignment for which personnel have not had time to be trained on yet.

**Option 2 - Set the frequency to "Repeat when course version changes":**

Specific re-training dates can also be managed through course versions. For example, you may create an Assignment and set the frequency to "Repeat when course version changes". Then, on the Course
Version History tab of the Course Form, set up the dates when the course version changes - such as:

Version 1: Effective Date: 1/1/2017  
Version 2: Effective Date: 1/1/2018  
Version 3: Effective Date: 1/1/2019  
, etc.

This option allows you to pre-define the re-training dates instead of having the re-training dates vary for each individual based on their last trained date.

5.4 Add an External Trainer

All personnel (internal and external) are tracked on the Personnel tab. You may distinguish an external trainer from your internal organization as follows:

2. For each external trainer, open the personnel form, and set their group to the name of the group you created in Step 1.
3. In addition, be sure to select the checkbox labeled, "Exclude from required training". This will ensure that the outside trainer does not appear on your required training reports (for example, for training which is required for "All Groups").
4. Also, select the "Trainer" checkbox. As with all trainers, this checkbox must be checked in order for the trainer name to appear in the Trainer list when creating a new Class Session record.

5.5 Export a report

Reports may be previewed and printed on the main Reports tab. Additional options including the option to export the report to another format are also available. This can be helpful if you would like to distribute the report outside of the Training Manager system. There are several export formats available. PDF Format is a popular choice to retain the formatting, and allow others to open the report with the free Adobe Acrobat Reader software.

Here are the steps to export a report:

1. Select the report to export on the main Report tab, and set the filter options as needed.
2. Click the "Open in new window" button located in the toolbar just above the report selection area.
3. In the new report window which opens, select the menu option File --> Export.
4. Set any options as needed, and then click Ok to select a location to save the report.
5. Click "Save" to save the report to the location you have selected.

5.6 Set or change a password

Training Manager has an option to "Set" or "Change" a password:

1. An Administrator can "Set" a password without knowing the current password.
2. A user can "Change" their password provided they know the current password.

**Option 1 - "Set" a password using Administrator privilege:**

1. Open Training Manager and log in with an account which is in the System Administrator role.
2. Open the Personnel form for the person's password you would like to set.
3. Click the "Set Password" button located next to the Login Name field.
4. Type the password in the "New Password" and "Confirm Password" fields, and then click Ok.
5. Click the Save and Close button on the Personnel form.

Option 2 - "Change" a password without Administrator privilege:

1. Select the Login Name of the user whose password you would like to change.
2. Enter the user's current password.
3. Enter a new password for the user.
4. Enter the new password for the user again to confirm it.
5. Click the Ok button to complete the change.

See also: Change Password

5.7 Add a read-only or administrator user

Training Manager users are managed on the main Personnel tab. A user who has been given a login name and password on the Personnel form can be assigned any of the following permissions:

- **Read-only**: Can view all areas of the database but cannot make any changes to the data.
- **Training Records Administrator**: Can view and edit all areas of the database except user permissions.
- **System Administrator**: Can view and edit all areas of the database including user permissions.

To set up a user with read-only permissions:

1. Locate the personnel record for the user, or create a new one if needed.
2. Assign a Login Name and set a Password if desired on the personnel form for this user.
3. Ensure that none of the System Roles have been checked for this user.
4. Save and Close the record.
5. Install the same version of the software on the user's computer if needed, and inform them of their Login Name and Password. The software is available to download in the Software Archive. See the menu option: Help --> About Training Manager for specific version details.

To set up a user with Administrator permissions:

1. Locate the personnel record for the user, or create a new one if needed.
2. Assign a Login Name and set a Password on the personnel form for this user.
3. Select the "System Administrator" or "Training Records Administrator" option in the System Roles section of the Personnel form.
4. Save and Close the record.
5. Install the same version of the software on the user's computer if needed, and inform them of their Login Name and Password. The software is available to download in the Software Archive. See the menu option: Help --> About Training Manager for specific version details.

For more information about permissions, see the Permissions Matrix.
5.8 Manage the system (technical)

Training Manager is designed to run with minimal system administration. However, there may be a time when you need to move the database, upgrade the software, set up scheduled database backups, or perform other non-routine system related activities which require additional technical information. Many of the common activities can be found in the System Administration section of this user guide. If you are unable to find what you need there, or need some additional help with one of the items, you may contact us at anytime through the Support options on our website.

6 Getting More Help

This User Guide provides commonly needed documentation for using Training Manager and can often help resolve questions very quickly. Be sure to check out the reference section for detailed information about specific areas of the program.

Technical Support and Customer Service is also available via email. You may contact us for additional help using the links below:

Contact Us

For Technical Support:
http://www.kzsoftware.com/support/index.htm

For Customer Service:
http://www.kzsoftware.com/contact/index.htm

Reach us by mail at:
Kaizen Software Solutions, LLC
39962 Cedar Blvd. Ste. 323
Newark, CA 94560-5326

7 How To Buy

You may purchase Training Manager online worldwide with any major credit card. Additional purchasing options including Phone, Purchase Orders, Bank Transfers, and Checks are also available through our reseller.

As soon as your transaction is complete, your license key will be emailed to you, and you can enter the license key to continue working where you left off.

Purchasing Links

Direct Order:

Additional Purchasing Options
http://www.kzsoftware.com/purchase/options.htm